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1 Warranty
ALLEN DATAGRAPH Digital Finishing Systems are warranted to be free of defects in 
both materials and workmanship. Should any part of this equipment be defective, it will 
be repaired or replaced, at the option of the manufacturer, at no charge for parts or factory 
labor for a period of one (1) year from the date of installation. All warranty services are 
performed at the Allen Datagraph factory.   Replacement parts not installed at the factory 
will be billed to the customer at regular prices and credit will be issued when the 
defective parts are returned. The customer is responsible for freight on warranty parts and 
repairs.

This warranty is void if:

The equipment has been damaged by negligence, accident or mishandling, or has not 
been operated in accordance with the procedures described in the operating instructions; 
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or:

The equipment has been altered or repaired by other than an approved service station or 
factory service center, or adaptations or accessories have been attached to the equipment 
that shall have adversely affected the performance, safety, or reliability of the equipment.

NO OTHER WARRANTY, EXPRESSED OR IMPLIED, APPLIES to the 
equipment. Allen Datagraph does not assume any responsibility for consequential 
damages occasioned by the equipment, or inconvenience or interruption in operation.
In case  of  unsatisfactory  operation,  Allen  Datagraph or  its  Dealer  should be  notified 
immediately.

2 Technical Support
Up to 4 hours of calls in technical support is available at no charge during the warranty 
period.  Technical support is available during business hours based on Eastern Time 
Monday thru Friday.   Technical support outside the limits stated will be billed at current 
rates.  

For Technical support call: 603-216-6344  

Service Policy.  All service is subject to ADSI service policy.  You can read the policy 
here: Web Site Copy / CD Copy

There are many online documents available to help you to use the AXXIS at our 
technical support page at http://www.allendatagraph.com. Then click on Technical 
Support and Online Documents then click on Axxis link under orange Label Production 
heading.

3 Setting up your i-TECH AXXIS Digital Label System
The i-TECH AXXIS Digital Label System consists of a Axxis Printer and a Axxis 
Finisher.  The Axxis printer consists of a printer base which supplies and takes up the 
printed media and an Epson B500 printer.

3.1 Installation of AXXIS printer
3.1.1 Setup printer base
The printer base is available as a paper supply only, and paper supply/paper take up 
mandrels.  The printer base is shipped assembled in the box.  So remove packing material 
and set the printer base on a table.

3.1.2 Place Printer on base
Place the printer on the base tray on the printer base.  The input paper port should face 
left and the control panel should face right.  There is no connection between the base and 
the printer.

3.1.3 Plug-in Printer Base

WARNING: THE B500DN PRINTER IS AVAILABLE IN 
TWO POWER MODELS.  YOU MUST ORDER THE 
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CORRECT MODEL FOR YOUR POWER SOURCE.  DO 
NOT PLUG PRINTER IN IF YOUR POWER SOURCE 
DOES NOT MATCH THE PRINTER MODEL YOU 
ORDERED.
Power requirements
Axxis Printer Base 200 watts voltage input ranges 100 -240 VAC / 47-63 Hz 
B-500DN printer 32 watts available in following voltage models 

90-132 VAC 49.5-60.5 Hz or 

AC 198V-264VAC 49.5-60.5 Hz 

Please refer to the Epson printer manual for instructions on plugging in the Epson printer. 
Important Note: Use of a HIGH QUALITY surge protector or uninterruptible power 
supply (200 printbase + 32 b500 printer = 232 watts) is REQUIRED by Allen Datagraph 
Systems.  Failure to do so could affect your warranty coverage if a problem arises due to 
improper power connection.

CAUTION: The power cord is a three-conductor cable that incorporates a safety (earth) 
ground connection. For the machine to operate safely and correctly, the power cord must 
be plugged into an outlet that has an earth ground contact. Never plug the power cord into 
a two-prong outlet by using a 3=2 cord adapter. 

CAUTION: Never allow roll or sheet goods to rub on the power cord because the 
material can cut the cord causing an electrical fire hazard!

3.1.4 Plug in the Printer
Refer to the Epson users manual for instructions on how to plug in the Epson printer.

3.1.5 Connection to PC
The connections on the printer base are only for loading firmware and running 
diagnostics.  See Appendix A. No connection is necessary to run the printer base.

The Epson printer can be connected to the PC via usb or Ethernet.  Refer to the Epson 
users manual for instructions on how to connect the printer to the PC.

3.1.6 Printer Base controls.
There are 3 buttons on the control panel of the printer base.  The power button turns 
on/off the printer.

The load button leaves the power on but stops both motors.

The take up button turns on and off the take up motor.

3.1.7 Epson CD-Rom
Each Epson unit comes with a CD-Rom that will guide you through an installation of the 
Epson B500 driver and connection. If there are any further questions on connections, 
please consult the supplied Epson CD-Rom or manual for the printer.
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3.1.8 Test Print
Once the Epson B500 driver is installed, it is recommended to perform a test print to 
ensure the connection to the printer is operational.

Click on the start menu of your Windows based PC and click on "Printers and Faxes." An 
icon specifying the Epson B500 should appear in this window. Right click on the icon 
and select "Properties," a new menu will appear with a "Print Test Page" option. If a test 
page does not print, go back to your Epson CD-ROM and check your setup or consult 
your Epson B500 manual.

3.2 Installing Wasatch SoftRIP
3.2.1 Wasatch CD-Rom 
Each complete i-Tech AXXIS Digital Labeling System comes with Wasatch SoftRIP, a 
program used to for roll-to-roll printing on a variety of different printers. To install 
SoftRIP, insert the CD-ROM into your PC and follow the prompts. If you have further 
questions about your SoftRIP installation, please consult your Wasatch SoftRIP user 
manual.

3.2.2 Setting up the B500 in Wasatch
To setup your Wasatch SoftRIP to manage your Epson B500 printer, follow these 
instructions:

1. Open Wasatch SoftRIP

2. Go to the PRINT menu at the top of the screen then select SETUP and a new 
menu will appear. 

3. Click the PRINTER MODEL dropdown menu and elect EPSON then B500DN 
from this menu.

4. To setup the physical connection so that SoftRIP knows what port the printer is 
connected to, click EDIT and then PROPERTIES. A new menu will appear. The 
bottom of the menu will list the physical connection. Select the Epson B500 from 
this drop down if it has not already been selected.

NOTE: If you are connected via Ethernet or LAN please consult the Wasatch manual for 
further information.

3.2.3 Test Print
To ensure the connection to the Epson B500 printer is operating correctly, in SoftRIP go 
to FILE then OPEN and select one of the training label files on the AllenDirectCUT CD 
"AxxisTrainingLabel_5_inch.eps", labels in CorelLabel.zip, IllustratorLabel.zip in the 
techsupport\axxis directory or any other EPS, PDF, JPEG or TIFF that may be readily 
available. The file will load in SoftRIP, to print it click on the printer icon at the top of 
the screen.
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3.2.4 Installing Color Profiles and Settings
During software installation in section 3.3.4 printer profiles will be installed. ADSI has 
provided a set of ICC color profiles and pre-existing settings that work with a variety of 
substrates on the B-500. Select the profile that fits closest to your current substrate, 
whether it is a matte or gloss paper or a BOPP Film, under the image configuration. If 
you would like to learn how to develop your own ICC profiles for your own materials, 
please contact Wasatch or visit their website for further instructions.

3.3 i-TECH AXXIS Installation
3.3.1 Setup finisher on table
The i-Tech AXXIS Finisher is a tabletop label finishing device. Once removed from its 
crate, place the unit on a table that can support 200+ Lbs (90 kg).  You need at least 4 
people to move the Axxis from the shipping crate to a table.

3.3.2 Power 

WARNING: IF YOU RUN YOUR EQUIPMENT ON 220V 
WITH INPUT MODULE SET FOR 110V IT WILL 
DAMAGE YOUR EQUIPMENT.
Important Note: Use of a HIGH QUALITY surge protector or uninterruptible power 
supply (600 watts) is REQUIRED by Allen Datagraph Systems. Failure to do so could 
affect your warranty coverage if a problem arises due to improper power connection.

CAUTION: The power cord is a three-conductor cable that incorporates a safety (earth) 
ground connection. For the machine to operate safely and correctly, the power cord must 
be plugged into an outlet that has an earth ground contact. Never plug the power cord into 
a two-prong outlet by using a 3=2 cord adapter. 

CAUTION: Never allow roll or sheet goods to rub on the power cord because the 
material can cut the cord causing an electrical fire hazard!

The finisher can be configured to operate from any of the following power sources:

100-132 VAC / 47-63 Hz or 180-240 VAC / 47-63 Hz

ALLEN DATAGRAPH products are normally factory preset for the power requirements 
of the destination country. The machine's configuration is indicated on the power input 
module as either 115V or 230V. To change the configuration:

a. Disconnect the AC power cord 
from the fuse block on the power 
input end panel.

b. Open the fuse block cover with a 
small flat screwdriver.

c. Orient  the  fuse  block  so  that  the 
desired voltage appears in the fuse 
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block cover.  If you have 110v ac use one 5 amp fuse.  If you have 220v ac 
use two 2.5 amp fuses.

d. Close the fuse block cover and verify that the desired voltage is showing.

3.3.3 Connection to PC
Do not connect the Axxis finisher to the computer until told to do so by the installation 
CD.  Connection from PC to Axxis Finisher is either by USB or Ethernet.  If you want to 
read about using the Ethernet port for the cutter see the document Website Copy /  CD 
Copy.

3.3.4 Allen Datagraph CD-Rom
The finisher utilizes either USB (universal serial bus) interface or Ethernet connection to 
the computer.

The Axxis comes with an installation CD that will walk you through connecting your 
equipment to your computer and installing software.  

The Setup CD contains:

1. An installation program that walks you through connecting your Axxis finisher to 
your computer.

2. The Remote Panel Utility program for managing finisher settings.
3. A current revision of firmware. "Firmware" is software that controls the machine 

functions.  The firmware on this disk is provided for update purposes only and  
should not be installed on new machines.

4. The  DirectCut  printer  driver.   This  driver  been  tested  with  AllenCAD, 
CorelDRAW  (versions  10-x5),  Adobe  Illustrator  (versions  10-cs5),  Flexisign, 
Inkscape,  and  PowerCAD.  It  should  also  work  with  any  program  that  sends 
vectors rather than bitmaps to the driver.   The DirectCut printer driver allows 
cutting  directly  from windows graphics  programs  without  requiring  additional 
software  purchases.  Note:  DirectCut  requires  ownership  of  Allen  Datagraph 
Equipment  to  use.  Requires:  Windows  7,  Windows  Vista,  or  Windows  XP. 
Updated versions of the DirectCut printer driver is available on the tech support 
page at the Allen Datagraph web site at  http://www.allendatagraph.com/.

5. During installation a test cut is performed.
6. Users Manual and sample jobs.
7. A complete copy of the technical support section of the ADSI website at the time 

the machine was shipped.  To access this offline copy of the web site answer no to 
question as to whether you want software installed on this computer.
If the CD does not auto start, open the file explorer, right click on the CD driver 
and select auto play.

3.3.5 Software Updates
Software updates after the product ships will be available on the tech support section of 
the http://allendatagraph.com web site.

To update to a later version of software when recommended to do so by the tech support 
department, go to the web site.  Click on tech support, then online documents.
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Select Axxis or Cutter driver from list of selections.

Find the software update and click on it to download the setup program from the web 
site.

4 Operation of the i-TECH AXXIS Digital Label System
4.1 Setting up your label job
The target should be a black rectangle on white 
media or a contrasting color to background.  See 
colors in Web Site Copy or CD Copy.  The 
recommended Mark Size is 0.25 inch (6 mm). 
The sensor relies on reading the change in 
intensity of the reflection of the red LED pointer. 
When printing process colors on white media the 
best color is usually black.  Certain spot colors are 
difficult.  For example silver spot on white, while 
to the eye there is contrast the reflectivity of the 
two is sometimes nearly the same.  If there is 
trouble with certain materials detecting the target 
you can print the target in a yellow or white field. 
The size of the yellow field should be double the 
scan length. (Note: in order to get an accurate 
scan no other printed marks may appear in the 
yellow or other high contrast colors scan area. 
The printer color alignment marks can appear on the inside edge of the target or the other 
side of the media.)

The mark should be placed at least 0.25 
inches (6 mm) from the edge of the media 
and the spacing between frames should be at 
least 0.25 inch (6 mm).  (Advanced usage: 
You can place the target closer to the edge 
of the material if you use inside out 
scanning.  See Web Site Copy or CD Copy)

The number of rows and columns of labels 
between registration marks defines a set or frame of labels.   A frame of labels can be one 
row or several rows of labels.  There are several aspects to consider when deciding on 
how many rows of labels to print on one page.  The main consideration is the trade off 
between speed (it takes a about second to perform the find origin (FO) command and 
scan the registration mark) and registration accuracy.  The more often you scan the 
registration mark (the closer the marks) the more accurate the cut registration will be.  If 
the job allows for overprinting the cut line, then registration may be less critical and 
eliminating some of the registration marks can speed the job.  Generally registration 
marks should be placed at least every 12 inches (305 mm) on Axxis.  Best practice is to 
print registration marks for each row then adjust the cut job to skip one or more marks if 
desired.  This procedure also insures equal spacing of the labels and gives complete 
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flexibility for cutting.  The distance between jobs, the last cut line of the previous frame 
and the target on the next frame must be between -4 and 4 inches (101 mm).  If the 
distance between frames is less than the scan length, then the target must be outside of 
the area where the labels are printed.  (Note: every frame of a label run must be identical 
or you won’t be able to use the copy command).  Maximum frame size is 14 inches (35.5 
cm) for units shipped after 5-1-10.

4.2 Explanation of SmartMarkTM

The theory of operation relies on the SmartMark sensor sending an analog signal to the 
embedded computer during a scan.  The data is analyzed after the scan to automatically 
create a threshold, find the edge of the target and eliminate noise.   The Axxis scans the 
mark in both x and y directions and calculates the intersection of the 2 scans.  The Axxis 
computer then assigns that intersection as the 0,0 point of the Axxis coordinate system 
and matches that to the origin point (minimum x, minimum y) of the HPGL cut file. 

The Axxis uses a special HPGL command, FO, to start the 
registration mark sensing function.  It automatically re-
registers the coordinate each time the FO HPGL command is 
received.  As part of the setup a “x move between jobs” is 
input via the printer driver options which moves the sensor 
to the approximate position of the next copy’s or next 
frame’s registration mark.  The Axxis expects the target for 
the next frame to be within ½ the scan distance of the end of the frame.

The Red LED pointer must be manually positioned with the joystick buttons at the 
approximate 0,0 coordinate position prior to sending the first job. The SmartMark 
system automatically repositions the sensor for subsequent copies.

The positioning process must be repeated if the joystick buttons are used.  This is helpful 
because it allows the system to be reinitialized when needed.  Some printers require a 
leader between jobs and this feature is a very easy way to deal with the issue.  

Once the LED pointer is positioned as shown, the SmartMark is ready to operate and 
will scan the registration mark when it receives a FO command in the job stream whether 
on the first copy or on subsequent copies.  Since the FO command is embedded in the 
beginning of the cut file the scan of the registration mark is performed at the beginning of 
each copy or frame of labels and on subsequent copies.

4.3 Types of SmartMarkTM Scanning
There are five types of SmartMarkTM scanning 
available.  They are shown in the image to the 
right.  The scan type is selected in the printer 
driver preferences.

Origin Only and Edge are the only types 
normally used on the Axxis.
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Origin Only is used on printed media where you want to cut out preprinted labels. 
Origin Only does a alignment with the visual sensor at the origin only.

Edge is used when you are cutting blank label stock.  Edge offset is used only when 
cutting blank labels on unprinted material. By selecting EDGE in the driver's printing 
preferences menu, the SmartMark sensor will detect the edge of the media instead of a 
registration mark, then offset into the media by that amount and cut your blank labels. 

Origin Skew is used if the media is not necessarily loaded straight.  This scans the origin 
and the skew mark and rotates the cut image to match the cut location at the two scanned 
locations.  Since the Axxis keeps the media straight you do not normally need to scan the 
skew mark.  No scaling of the cut image is performed with Origin Skew scanning.

Origin Skew Scale does alignment at the origin, rotation and scaling in both x and y axes 
are preformed.  This scan type requires that the sensor size parameter be correct so that 
cut image is same size as printed image.  Normally the y axis does not have any scaling 
errors on the printer so you do not need to correct the skew point and scaling at the scale 
point.

Origin Scale does alignment at the origin, rotation and x-axis only scaling at the scale 
point. It assumes that the scaling in the y-axis is correct.  Normally you do not need to 
scan the Scale location because if you have a scaling error in your printer it is normally in 
the x axis and it is very consistent.  If the printer you are using has a x axis scaling error 
you can normally correct this either in the printer or you can use calibrate to printer to get 
the Axxis to cut the same size as the printer.

4.4 Designing Labels
4.4.1 Planning Label
This tutorial will design a label for the 
Axxis printer and finisher with 
Illustrator and CorelDraw.  It will 
show how to create a bleed area to 
minimize visual errors on the 
completed label.  First we define our 
layout for a set of four 3x5 labels so 
we can create a set of locations in the 
artwork generation program 
workspace.  We lay out the frame with 
the x axis (media movement going up 
and down on the screen and the y axis 
(operator/front to gear/back).  The 
target in this orientation appears in the 
upper left corner of the screen.  This 
allows for no rotation when the 
sending the job to the printer.

Then add the target
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Then add 0.50 bleed on one label

So we need horizontal locations at:
0 , 5, 5.25, 5.3, 10, 10.2, and 10.25 

and vertical locations at
-0.5, -0.25, 0, 0.05, 2.95, 3, 3.25, 6.25

Add one to vertical so they are all positive numbers
0.5, 0.75, 1, 1.05, 3.95, 4, 4.25, 7.25

Now that we have work space planned choose program to design 
your artwork.  

4.4.2 Using Adobe Illustrator
Open Illustrator and create a new document.

Change units to inches

Click OK

Click on view -> rulers if rulers missing

Click on window -> layers if layer menu missing

Click on window -> color if color menu missing

Now create two layers.  One called “dielines” and one called 
“print”.  This is done from the layer window.  Click on new 
layer button.  Then rename the layers as dielines and print by 
double clicking on layer name, changing name and clicking 
on OK.

Next create the die lines.  Click on the dielines layer 
on the layer window.

Create the die line for the target

Click on line segment tool  and then click on 
layout area

Enter length 0.125 and angle = 0°

Click on object -> transform -> rotate enter 90° and 
click on copy.

Using transform panel move top of vertical segment 
to x = 0.5, y = 10.25.

Move left of horizontal segment to x = 0.5, y = 10.25.
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Click on rounded rectangle from tool menu and then click on layout window.  Enter 
the 2.9 for width, 4.9 for height and 0.166 for corner radius.  Using transform panel move 
object so the lower left as at 1.05, 5.3.

Then click object -> transform -> move.  Enter distance of 3.25 angle 0°, then click copy.

Select both rounded rectangles.

Then click object -> transform -> move.  Enter distance 5.25 angle 270°, then click copy.

This completes die line layer

Next create the print.  On layer menu select print layer

To create the target, click on rectangle tool , click on layout window, enter 0.25, 0.25 
for size.

Using transform panel move lower left to 0.5,10

On the color menu select fill and change color to black

Change out line stroke to none.  The target color should look like this when 
you are done.

Note: if not have a stroke on the edge of the printed target the print and cut will not line 
up.

To create the bleed background, click on rectangle tool, then click on layout window. 
Width 3, height 5

Move lower left corner x = 1, y = 5.25

On color window, select cmyk fill to k=85 cmy=0, and no 
stroke on color menu

Now paste in foreground of label. (I used file 
ICON_Axxis_Cutter.bmp.)  Size and center label on 
background just created.

Select background and foreground of label. Then click on 
object -> group

Then click object -> transform -> move.  Enter distance 
of 3.25 angle 0°, then click on copy button.

Select both print labels

Copy the two labels with distance 5.25 angle 270°

This completes the print layer.

This completed label file is at this link Web Site Copy / 
CD Copy.

Use File -> save to save the file on your hard drive. 
Use file type EPS so it can be imported into Wasatch.
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4.4.3 Using CorelDraw
First setup workspace to Allen Datagraph.

Open CorelDraw, Select -> tools -> options -> work space.   Place a checkbox in front of 
Allen Datagraph.

Next turn on 2 dockers:

Select Window -> Dockers -> properties

and

Window -> Dockers -> Object Manager

Verify snap to guide lines is checked from the view 
menu.

This adds two control windows on the right side of 
the program

Now we can start the design.  First we enter the 
guidelines

Select Tools -> Options -> Document -> Guide 
Lines -> Horizontal

Enter the horizontal guides determined in the layout 
(0, 5, 5.25, 5.3, 10, 10.2, and 10.25).

Then select vertical and enter the vertical guides 
(0.5, 0.75, 1, 1.05, 3.95, 4, 4.25, 7.25)

When done your workspace will look like this.

Now create two layers.  One called “dieline” and one called “print”.  This is done from 
the object manager tab.  Click on new layer button.  Then 
rename the layers as dielines and print by right clicking on 
layer name.

First create the die lines.  Click on the dielines layer on the 
object manager.

Use freehand tool to draw a two sides of the target..

The use the object properties to verify the pen nib tab  
has width of hairline, color black.  On the paint bucket tab 

 verify no fill  selected.  When you are done the die lines 
for the target should look as follows:

Next use the rectangle tool  to draw a rectangle on the inner 
guide lines (1.05,5.3 to  3.95,10.2.).  Select the rectangle and 
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using the object properties / rectangle tab  change the corner roundness to 15.  The 
die line will then look like this.  

Using copy, paste, and arrange -> transformations -> position move copies of rounded 
rectangle to each of the following relative positions from the first rectangle.

3.25, 0
0,-5.25
3.25,-5.25

The dielines layer is now complete. 

Now in the object manager right click on dielines layer and uncheck the 
visible so rest of label creation does not change the die lines.

Select the print layer so objects create reside on this layer

Draw a rectangle from outer guide lines (1,5.25 to 4,10.25). Then fill the 
rectangle with the object properties paint bucket, uniform fill, bleed color 
and apply.  Next insert the artwork for the label and center it in the label. 
(I used file ICON_Axxis_Cutter.bmp.) 

Select the label and the bleed using shift key to select 2nd item.  Group 
them with arrange -> group.  Using same procedure as above copy, paste, 
arrange -> transformations -> position move copies of printed label to 
each of the following relative positions from the first rectangle.

3.25, 0
0,-5.25
3.25,-5.25

Lastly draw a filled rectangle with no lines in the target 
position.  Using object properties pen nib tab, select width = 
none.  On the paint bucket tab select uniform black fill.   

Note: The Axxis will not align print to cut correctly, if you 
have a pen width defined.

The completed label file is at this link Web Site Copy / CD 
Copy.

Use File -> save to save the file on your hard drive.  Then use 
file export to export file as  as EPS so it can be imported into Wasatch.
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4.5 Webbing the printer

Refer to the Epson's instruction guide ("Using the Epson B-500 with Roll Media") that 
was included with the B-500 roll printer, before threading the web - especially the 
"Loading Roll Media" section of the instruction guide

The diagram above shows the media path. Turn on the printer base station and press the 
load button and off the takeup button. Take a roll of media with a width between 4 and 8 
½ inches and place it on the infeed mandrel of the print station, lining it up with the very 
back edge of the mandrel. Once the paper is lined up, lock it in place by twisting the red 
handle on the mandrel clockwise.

Next, open up the drive nip and feed some paper between the nip rollers. Making sure the 
paper is straight, lower the drive nip. Raise the dancer bar slightly so the nip begins to 
feed more material. Feed enough material through to put underneath the dance bar and 
then into printer.

When you have fed the paper underneath the dancer bar, Feed the end of the roll media 
into the manual feed slot at the back of the printer.  Looking down from above, align the 
left edge of the media with the white plastic tab shown below. 

Once it is straight, guide the media into the slow until you hear the printer feed motor. 
Hold the media in place for 3 seconds or until the printer feeds it in.
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To feed the media all the way through the printer, hold down the  button on the printer 
control panel.  Continue feeding media until enough (to go over the guide bar and 
underneath the next dancer bar) emerges for you to attach it to your uptake mandrel.  Put 
a core on the uptake mandrel, lining it up with the back of the mandrel to ensure proper 
tracking. Tape the paper to the mandrel and then press the TAKEUP button on the printer 
base. 

Caution: NEVER pull roll media through the printer with your hands or 
you may damage the printer.  Always use the  and  buttons to feed 
media.  Check to make sure the media is straight all the way through the 
"web" (paper path of the roll media feeding system).  Adjust the media 
position, if necessary.

4.6 Printing your label
4.6.1 Loading File into Wasatch
Refer to the Wasatch users manual for additional instructions on using Wasatch rip 
software.

Open Wasatch SoftRIP and go to FILE and OPEN. Browse to the file saved from Adobe 
Illustrator or CorelDraw and open it. The file should appear in the job tab. You should 
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have 3 tabs at the top of the screen; job, layout and queues. A template tab will be 
available if you have purchased Wasatch’s variable data option. 

The job tab allows you to prep the job before printing an entire roll of labels. Using the 
cursor click on the image and draw a selection box around the area you wish to print. 
This box can be adjusted by clicking on the edges and dragging them where needed.

Once selected, the file must be rotated so that the labels are in the right orientation when 
they need to be finished. Using the rotation arrows at the top of the screen, rotate the 
labels 90 degrees so that the SmartMark is in the lower right hand corner of the print. 
Making sure that the SmartMark is in this corner will ensure that the labels will not have 
to be re-rolled after printing.

4.6.2 Set paper width
To set the media width, go to PRINT then SETUP. 

On the right side of the Image Configuration will be an EDIT button. Click and a new 
menu will appear. Click Properties and another menu will appear. In this menu, there are 
several features you can alter just as you would on any home or office deskjet printer. 

Set the width of the media. All units in Wasatch are in inches, to change this option in 
Wasatch, please consult your Wasatch manual.

Once the media width has been set, press OK and then press OK again on the previous 
menu until the initial print setup window is in view. Next to the paper width select “Set 
Maximum Width” and then check the “Width Center” box. This will ensure that labels 
are printed in the center of the media.

4.6.3 Test print
Simply press the printer icon button and one copy of the image will begin to print.

4.6.4 Load label into layout tab
If the test print is acceptable, right click on the image in the job tab and select “Add To 
Layout.” The image will appear in the layout tab. Right click the image again and select 
ADD COPIES, enter the number of copies you would like to print and press OK. 
Wasatch will populate the layout tab with that many copies.

On the left of the screen is a tab called UNIT OPTIONS. In this tab you can specify the 
gap between labels. The default is .125 inches but can be changed to your specification.

4.6.5 Print
Simply press the printer icon button and the job will begin to print.

4.7 Webbing the AXXIS
The Axxis loading instructions are in the following linked document. Web Site Copy / 
CD Copy. 
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4.8 Axxis Web Tension Controls
The tension settings on the back of the Axxis allow controlling the tension on the web. 
You should use more tension on wider materials and less tension on narrower materials. 
If you are seeing drift left and right you probably need more tension.  If the web is 
breaking or the laminate stretching you should use less tension. 

The weed or matrix tension is not based on the width of the material but the width of the 
matrix that is left after you remove it from the backer.  If you matrix is breaking you can 
move the tension lever towards the less position.
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4.9 Cutting your label
After webbing the finisher, press the load button on the front panel to fill the input 
accumulator and empty the takeup accumulator.  This makes the finisher ready to receive 
data.

4.9.1 Force and speed
To adjust speed and force applied to knife use the up and down arrow buttons on the front 
panel.  Start with speed = 100% and force of 30%.

4.9.2 Test cut
Pressing the TEST CUT button on the front panel of the finisher will perform a set of 2 
circles, square, and triangle cut on the paper.  Use the buttons around the select key as a 
joystick to move the carriage to show the cut pattern.  Then use a tweezers or a matte 
knife to pluck out the circle and the square.  Face doc should pull away from backing and 
not rip.  Then pull out the triangle and inspect the backing.  If the force is adjusted 
correctly you will see a light scoring of the backing material.  Increase the force to apply 
more pressure to the knife.

4.9.3 Lining up SmartMarkTM

Use the buttons around the select key to move the carriage 
left, right, forward, backward until the led pointer is within 
1/8 inch (3 mm) from the gear side take up corner of the 
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target to be scanned.  The gear side of the machine is away from the operator.  The take 
up side is on the right as you look at the machine.

4.9.4 Sending file with Illustrator
Load the file you want to cut with Adobe Illustrator.  If the layer window is not visible 
you can make it visible by clicking on Window -> Layers.  Select the dielines layer on 
the layer menu.  Click on File -> Allen DirectCut to open the DirectCut for Illustrator.

4.9.4.1 Sending file with CorelDraw
Load the file you want to cut with CorelDraw.  If the object manager is not visible you 
can make it visible by clicking on Window -> Dockers -> Object Manger.  Select the 

dielines layer on the object manager tab.  If the Allen DirectCut tools  does not 
appear near the view button, select Tools -> Options -> WorkSpace.  Then check Allen 
Datagraph.  Click on the Allen DirectCut button to open the DirectCut for CorelDraw 
preview window.

4.9.4.2 Origin only
Verify the printer you want to send the die lines to 
appears in the drop down box between the Cut and 
Properties button.  Click on the properties button and 
select find origin type you want to use.  Select origin 
only for normal use.

4.9.4.3 Sort Method
Use sort method Closest point for optimum output 
path.

4.9.4.4 Rotation 
In the preview window select DFS origin.  This 
moves the origin to the upper right on the screen. 
This matches the view you see when you look at the 
front of the Axxis. Use the rotate selection in the 
properties until the origin of the preview is in the 
upper right.  Select rotation from (none, 90°, 180°, or 
270°). 

4.9.4.5 Space between jobs
The space between jobs is the distance between the 
last cut of the previous frame to the leading edge of the target of the next frame. In the 
case of the sample label designed earlier the space between jobs is 0.050 inch (size of 
bleed) and the space between prints.  Since we designed the label panel with 0.25 inch 
between the two rows, it make since to set the space between labels on the print to 0.25 
inch so the total space between jobs should be set to 0.3.  If you want the space between 
jobs to be the same as the space between prints you need to add a small cut object at the 
end of the print.
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4.9.4.6 Multiple pen output
If you are using a single color and a single force set multiple pen output to No.  If you 
want two different forces applied to knife during frame you have to set multiple pen 
output to Yes.  You can then turn on Send Force to tool and select different forces for 
different pen colors.  

4.9.5 Cutting label
After you have set the properties click OK to close property window.  Then click on the 
Cut button to send the job to the finisher.  Once correct job is sent to finisher the 
computer can be used for other purposes as you can use the copy button on the front 
panel to send additional copies of the frame to the finisher.  Select copy,  use up/down 
arrows around select key to select number of copies or select -1 for copy count for count 
up mode.  Then press select key.

4.9.6 i-TECH AXXIS Remote Panels and LCD panel
The Axxis has a 4 digit display and a 16 button panel.  The display is used to interact 
with the operator showing current status.  If the menu is not active the first digit is C for 
cut,  2nd digit is speed (0 = 0-4%, 1= 5-14%, 2= 15-24% ...), and last 2 digits are force.

4.9.6.1 i-TECH AXXIS finisher remote panel
The remote panel is installed by the installation CD.  It appears as an icon on your 
desktop and in the start menu at Start -> All Programs -> Allen Datagraph.  Double click 
on the icon on the desktop to start the remote panel.
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4.9.6.2 Action Menu
4.9.6.2.1 Save / Restore Calibration
This command saves line sensor parameters that depend on the calibration and calibration 
of the Axxis or allows loading the calibration parameters from a file.  This command 
allows calibration of the Axxis to 
multiple printers.  It also allows 
backing up your settings to your hard 
drive in case of inadvertent operator 
changes to settings.

4.9.6.2.2 Load / Save Settings 
from Cutter to File, 

These commands save the settings 
(see setup settings menu) and some 
line sensor parameters that are in the 
Axxis to a disk file or loads settings 
saved by this command from a file 
and sends them to the Axxis.  This 
allows you to have more than 6 
setups for different materials.  It also 
allows backing up your settings to 
your hard drive in case of inadvertent operator 
changes to settings.

4.9.6.3 Setup -> Main Menu
The Main menu opens the main menu window.  The top window shows the model 
number and firmware version (build 23 in the sample).  The media height window shows 
the maximum dimension the y axis is set to cut.  The AXXIS will send this dimension 
(called the clip limits) to the software program so that the software program can 
determine if the specified cut file will fit.  If a file with dimensions larger than the clip 
limit is sent to the AXXIS, the cut will be truncated.  The position window shows the 
current location of the knife in the AXXIS coordinate system.  The Last Saved Error 
Message window displays the last error.  Errors displayed here may be old.  The error 
may have occurred earlier in the AXXISs life.  The Clear Error button clears the memory 
of the saved error notification.  Some features are advanced and only appear if menus = 
advances is selected in setup → options.

4.9.6.3.1 State Tab

The State radio buttons allow the user to set the condition of the AXXIS.  Unload means 
the AXXIS is not loaded and is not ready to receive a cut file. The Pause radio button 
means the AXXIS is currently paused and the Ready button means the AXXIS is loaded 
and ready to receive the cut file and proceed with cutting.  This set of buttons duplicates 
the Load and Pause buttons on the front panel.

The Cad Override radio buttons enables or disables the CAD override function.   With 
the function On, the AXXIS will ignore some of the HPGL control commands sent from 
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the cutting software.  With the function Off, the software can control these HPGL 
functions.  Some CAD systems will work correctly only when this feature is set to on.

These commands include:
AS set acceleration
FS set force
KA set minimum angle
KN set knife offset
IP input P1/P2
RO rotate
SC set scale
SP select pen
ST select tool
UV up velocity (move speed)
VS down velocity (cut speed)

The Mode radio button sets the operation.  Select cutting, pen plotting/drawing or 
pouncing.  The AXXIS will normally only use the Cut function.

The Dynamic Force radio buttons (an advanced option) engages the dynamic force 
function, which instantaneously adjusts the force on the fly based on the actual velocity 
of the knife blade.   All AXXISs must accelerate and decelerate as they cut around 
corners.  Some medias require different force settings for different speeds.  This 
parameter allows for building a database for these materials and when enabled will 
greatly improve the cutting on these materials. (See the Setup → Dynamic Force  for 
more details).

4.9.6.3.2 Knife Settings Tab

Draw Speed displays and sets the 
velocity of the knife when it is 
actually drawing or cutting.  The draw 
speed is the speed the knife travels 
around the periphery of the items 
being cut.  

Force displays and sets the cutting 
force. The range of force is 1 to 100% 
represent 10 to 550 grams of force.

Knife Offset is the distance between 
the center of the knife blade and the 
knife tip.  Allen Datagraph blades 
have a 0.012 inch (.030 cm) offset.  If 
you have objects that do not close 
correctly, you might have to adjust the 
knife offset to correct the problem.
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4.9.6.3.3 Rubber Tab
This tab is not used on the AXXIS unless you are doing stencil cutting at high 
force values.

Rubber Minimum Angle displays and sets the angle between consecutive vectors that 
when exceeded will invoke the tangential emulation mode.  At angles less than the value 
set in this parameter the AXXIS will move between vectors without evoking the 
tangential emulation mode.

Stencil Force is the force separation between drag knife mode and tangential emulation 
cut mode.  Tangential emulation cut mode is normally used for rubber or very heavy 
material.  The AXXIS will normally not cut this type of material so this value should be 
set to a high force %.

4.9.6.4 Setup -> Line Sensor 
Clicking on Setup Line Sensor menu opens the 
SmartMarkTM Menu.

4.9.6.4.1 Line Sensor Tab   

Sensor Offsets - The SmartMark sensor is offset 
from the center of the knife.  The sensor offset 
distance is preset at the factory or during 
installation, but may need to be adjusted on 
occasion. The AXXIS can automatically calculate 
and set the SmartMark offset and sensor size 
parameters.  See drawing for definition of sensor 
offsets. See TSB Title Calibration  Web Site Copy / CD Copy  

X/Y Sensor size is the offset from the exact center of the red dot of the SmartMark 
sensor to the sense radius and may change based on sensor sensitivity or media 
reflectivity.  This parameter is best set using the procedure in the TSB above.  The Sensor 
Size parameter is only useful in origin scale and three target scanning.  If you are not 
using these methods you can set the size to 0.02 and the sensor size is included in the 
sensor-offset parameter.

Scanning Parameters

The AXXIS SmartMark system 
has adjustable scanning parameters 
to allow for different size and style 
of registration marks.   The primary 
parameters are the scan offset and 
length.  The ideal X and Y offsets 
are one-half the mark size and the 
ideal scan length is two times the 
scan offset. 
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To set the parameters type in the desired numbers in the X Scan Offset, Y Scan Offset and 
Scan Length. When you have entered the desired values click on OK. (see also section 4.2 
Explanation of SmartMarkTM).  The scan length should = the mark size.

x/y Scan Offsets This is the distance to move in x and y to perform the scan.  It should be 
1/2 the scan length.  The signs of scan offset for origin target should be +X/+Y.

Scan Velocity (default 2) sets the speed of the scanning.  Depending on the media and 
registration mark contrast, this parameter may need to be adjusted.  The better the 
contrast in reflectivity the faster the scan velocity can be set.  If you are experiencing 
missed registration marks, you may need to reduce the scan velocity.  

X move between jobs is the distance after the farthest excursion of the x-axis during a 
frame that the AXXIS should advance to find the target in the next frame of labels.  This 
item is duplicated in the DirectCut printer driver as the space between jobs.  These two 
parameters are added together so set this value to 0.

Target Scan Direction sets the direction of the scanning operation.  For single mark 
origin scanning the default target scan direction is +X, +Y.  There may be circumstances 
where it might be desirable to reverse the scan direction.  For instance, the mark might be 
printed to close to the trailing edge of the preceding labels limiting the distance available 
for scanning.  In this instance, it might be desirable to reverse the scan direction in this 
axis.  Consideration must be given in the cut file because the inside edge of the mark will 
be considered as the 0,0 point for the AXXIS coordinate system.  This is an advanced 
menu option and must be enabled on the setup → options page.  See also Web Site 
Copy / CD Copy.

4.9.6.4.2 Skew Tab 

The SmartMark system can use 
one, two or three registration marks. 
In standard operation the AXXIS 
only requires one registration mark 
to accurately cut the die lines of 
most labels. If, however, there is a 
problem with the printing it may 
become desirable to use multiple 
registration marks.  (see also 
discussion about marks in Tutorial 
Using Adobe Illustrator section)

When using two registration marks the 
embedded computer in the AXXIS will 
automatically scan both the Origin Point and the 
Skew Point.  This is helpful if the printing is 
skewed in relationship to the media.  
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When using multiple registration points it is helpful to understand the FO command and 
its parameters.

X, Y Scan offset.  This is the distance from the skew point to perform the Y and X scans 
to find the skew point.  With the targets defined as above, the +X, -Y is the correct signs 
for the scan offset for the skew mark.  

Scan Skew Point - A fourth scanning mode is implemented that performs scaling and 
skewing by scanning only two marks (origin and scale).  This method assumes there is no 
scaling error in the Y-axis.  (Specify the Origin, Skew, and Scale mode in your artwork 
software).  By selecting the scan skew mark off, the AXXIS will only scan the Scale and 
Skew mark and perform X-axis scaling and skew correction.  This parameter should 
always be on unless your printer driver does not support origin scale processing.

Target Scan Direction sets the direction of the scanning operation.  The skew mark is 
normally scanned +X,-Y.  See Web Site Copy / CD Copy.

4.9.6.4.3 Scale Tab   

X, Y Scan Offset.  This is the distance 
from the scale point to perform the Y 
and X scans to find the scale point. 
With the targets defined as above, the 
-X, +Y are the correct signs of scan 
offset for the scale target.

Target Scan Direction sets the 
direction of the scanning operation. 
The scale mark is normally scanned 
-X,+Y.  There may be circumstances 
where it might be desirable to reverse the scan direction.  See Web Site Copy / CD Copy.

4.9.6.5 Setup -> Settings Menu
The AXXIS allows six factory or 
custom set-ups.

Set-Up 1, whether standard or 
modified, is automatically loaded 
at power up. A user may modify 
the speed, force, (or any feature) 
on the control panel. See key 
command summary. Changes to 
a Set-Up, unless saved, will be in 
effect only until changed from 
the control panel,  CAS software, 
the unit is turned off or reloaded. 

Any of the features shown in the 
Setup Form may be saved to one 
of the systems 6 memory locations.
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To save a custom set-up simply fill in the desired value(s) in the appropriate window, 
including the Setup Number, click on the Save Setup button.  Some features are 
advanced and only appear if menus = advances is selected in setup → options.

To load the edit boxes with the current system parameters, input the setup number in the 
Setup Number window and then click the Load Setup button.

Setup Number sets the memory position.

Draw Speed is the velocity of the knife when cutting (e.g. while the knife is down).

Move Speed is the velocity of the knife when in the up position (not cutting).

Force controls the down force or pressure on the knife.
Knife  Offset All  drag  knife  cutters  use  a  knife 
blade  with  the  tip  offset  from  the  center  of 
rotation.   As the AXXIS moves  the  knife  trails 
behind it, just like a caster on an office chair.  In 
order to accurately cut the outlines, the computer 
embedded  in  the  AXXIS  compensates  for  the 
offset of the knife.  This parameter sets the offset 
for  those  calculations.   The  figure  to  the  right 
shows the path the knife follows; the radius move at the corner allows for the knife offset. 
There  are  three  blades  available  from  our  online  store  our  online  store  at 
http://www.allendatagraph.com.

H20-017 30° Allen Datagraph i-TECH, DFS, Centra, Axxis cutting blade.  Ideal for label 
stock. Angle of blade at 30 degrees to have exact control on depth of cut.  This blade has 
a 0.012 inch (0.0305 cm) offset.  It can be identified by its blue plastic cap.

H20-007 45° Allen Datagraph i-TECH, DFS, Centra, Axxis cutting blade.  Ideal for 
general purpose cutting of vinyl and other thin materials. Angle of blade at 45 degrees to 
balance depth of cutting and pivot angle.  This blade has a 0.012 inch (0.0305 cm) offset. 
It can be identified by its red plastic cap.

H20-008 60° Allen Datagraph i-TECH, DFS, Centra, Axxis cutting blade.  Ideal for 
cutting thick materials. Angle of blade at 60 degrees to optimize cut angle.  This blade 
has a 0.012 inch (0.0305 cm) offset. It can be identified by its green plastic cap.

Minimum Angle The AXXIS must stop and then accelerate whenever it makes a sharp 
turn.  At shallow angles the AXXIS can continue at the cut velocity without decelerating 
then accelerating.  This parameter sets the angle where below which the AXXIS can 
continue without stopping.  High values increase throughput and lower value increase 
quality.  Good quality can be obtained at reasonable speed at the default value of 12°.

Hole Distance displays and sets the distance between holes when the AXXIS is used in 
the pounce mode.

Tear Size displays and sets the hole size created when the AXXIS is in the pounce mode.
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Acceleration displays and sets the servo acceleration.  The unit of measurement is 1/4 
G’s or 8 feet per second per second.  This parameter is more important in small graphics 
than in large labels or text.   A setting of 2 to 8 is generally the best for most label cutting. 
This parameter does affect throughput speed on graphics with short vectors.  As the 
graphics get larger the effect of higher acceleration diminishes.  Higher acceleration can 
degrade cut quality.  Use smaller acceleration numbers for heavy materials.

Load Speed displays and sets the speed of the material loading and the speed of the 
material pull off in the service loop mode.

Load Length displays and sets the length of the material that is pulled during the load 
cycle and service loop if the AXXIS service loop mode is on.  

Service Loop This should be turned off on the AXXIS when the AXXIS is in the 
Label Mode.

Cad Override On or OFF enables or disables the CAD function.  With the function On 
(disabled), the AXXIS will ignore some of the HPGL control commands sent from the 
cutting software.  With the function Off, the software can control these HPGL functions.

These commands include:
AS set acceleration
FS set force
KA set minimum angle
KN set knife offset
IP input P1/P2
RO rotate
SC set scale
SP select pen
ST select tool
UV up velocity (move speed)
VS down velocity (cut speed)

Mode sets the operation mode. Select the operation mode cutting, pen plotting/drawing or 
pouncing.
To restore the factory default to all setups click the Restore Default button.
To load a setting enter setting number desired and click on Load Setup.
To save a setting enter setting number desired and click on Save Setup.

4.9.6.6 Setup -> Options 
Menu

The  options  menu  displays  and 
sets the following parameters:

Auto Origin Offset determines 
whether moving the joystick 
automatically sets the origin to (0,0). 
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Most CAD systems and the Allen DirectCut printer driver require this option to be set On.  Set to 
Off when cutting from a CAD system that does not use the SmartMark sensor such as the 
Gerber Omega software.

Language determines which language the AXXIS uses.  Select HPGL for most cad 
systems and the Allen Printer Driver.  If you are using Gerber Omega select Gerber.  If 
your cad system only outputs dmpl you can select this language.

Menus option offers the more advanced features of the software.  It is recommended this be set 
to Normal until a more advance feature is understood or is required by your operation.  The menu 
items below are displayed when the menus is set to Advanced

Units sets the units of measure to English or Metric units.

Model sets the model number.  Password for model number change is 23.  Do not change 
the model number unless you know what you are doing.

4.9.6.7 Joystick
JOYSTICK The joystick is used for positioning the 
knife and media in the die cutting station.

The four ARROW KEYS are used to jog the 
material or AXXIS carriage that holds the knife 
blade and the SmartMark sensor.   With the 
Jog/Slew box unchecked so that Jog/Slew = Slew, 
the joystick speed will be the speed set in the 
Joystick Speed Window.  Left Click and hold the arrow button to move the material or 
carriage.  With the Jog/Slew box checked so that Jog/Slew = Jog, the arrow buttons will 
jog the AXXIS that fixed distance each time the button is clicked.  

The setting in the Jog Distance Window also sets the jog distance for the Front Panel 
Joystick buttons. 

4.9.6.8 Front panel of i-TECH AXXIS Finisher
The front control panel is the primary user interface for the AXXIS.  It is used for input 
of speed and force as well as several other functions.  

LOAD The load key is used to initialize the system and to load or automatically fill the 
supply accumulator.   Once the material is fed thru the media path and the nip rollers are 
engaged (see section 4.7 Webbing the AXXIS), press the load key and the supply roller 
will start feeding media into the supply dancer bar and will automatically stop once the 
supply dancer bar reaches the bottom and the input accumulator is full.  The load light 
will then come on to indicate the system is ready to operate.  Be sure that the label frame 
you want to cut is at least 2 inches behind the llade before pressing load.

PAUSE The pause key will halt the operation of the system at any point.  It is used to 
pause the system for inspection, media jams or to pause the machine for any other reason. 
Press the pause key to resume the system.  The system can be jogged while paused and 
will remember where it was and resume from where it was stopped regardless of where it 
was jogged.  This is very helpful for inspecting the cut.  You can pause the system and 
joystick the media or cut head away from its position to inspect the cutting or registration. 
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After inspecting the media, simply press the pause key again and the AXXIS will return 
to the point where it was paused and resume cutting.  The pause light will flash while the 
system is paused.  You can also use the pause button to enter the unload state (press 
Pause followed by Load).

COPY The copy key is used to 
input the quantity of copies the 
AXXIS will digitally die cut.  It is 
used after the first copy of the job 
is cut. Once the first copy is cut 
and you are happy with the results, 
press the copy key.  The display 
will read 0001.  The number 
represents the total number of 
copies including the first one run. 
Increase the number of copies by 
pressing the up arrow key of the 
joystick or the force up button. 
Hold the key down and the 
numbers will start moving slowing 
then more quickly.  Press the down 
arrow key to lower the number. 
Alternatively the force keys will 
increment the single digits and the 
speed keys will increment the 10’s 
digits.  If you enter 0 the copy will 
stop at end of next job.  If you 
enter -001 then it will count up 
forever.  Remember the number 
displayed includes the first copy 
run before the copy key was 
pressed. Input the copy quantity and start the cutting by pressing the SELECT KEY.

SPEED The speed keys are used for controlling the cut speed (the speed the knife travels 
around the periphery of the items being cut).  Increase the speed by pressing the up arrow 
key.  Decrease the speed by pressing the down arrow key.  Hold the key down and the 
numbers will start moving slowing then more quickly.  

FORCE The force key is used in conjunction with the test cut key to set the depth of cut. 
The range of force is 1 to 100% when the system is in the normal force range.  For most 
applications the normal force range is adequate.  In the normal force range mode, the 
force is adjustable between 10 and 550 grams of force in 100 steps.  

The force is set by test cutting the media to be cut using the test cut 
function.  Using the joystick, position the knife in an unused portion 
of the media and press the TEST CUT key.  The system will cut a 
test cut pattern similar to the diagram to the right.  With a sharp knife 
or tweezers you should be able to individually remove each part of 
the test cut pattern working from the ring to the triangle without 
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affecting the remaining parts. A properly set force will leave a very slight scratch or mark 
on the liner.   

The force may need to be adjusted due to blade wear during use if problems with 
weeding occur.  Simply increase the force setting by one until satisfactory weeding 
occurs.  If the knife blade is changed, revert back to the original setting or perform the 
test cut procedure again.  The blade may need to be replaced if the force is increased by 
more than 20 percent from when the blade was new.

F1 This key puts the pen up or down during digitizing mode.

F2 This key turns on/off the supply nip roller

F3 This key turns on/off the take up nip roller

RESET the AXXIS by pressing the F1, F2 and F3 keys in order.

JOYSTICK The joystick is used for positioning the 
knife and media in the die cutting station and for 
several other functions.  

The four ARROW KEYS are used to jog the material 
or AXXIS carriage that holds the knife blade and the 
SmartMark sensor.   Press the key once to move the 
material or carriage slowly and press it a second time 
within ½ second to move at a faster speed.  Tap the key 
to jog the AXXIS a fixed distance.  The distance is 
adjustable (see Joy section below or joystick in the 
Remote Panel section).

SELECT The select key is used to invoke the menu system.  Press the select key and the 
display will change to indicate the last used menu item.  To select a menu item press the 
select key and then press the right or left arrow key to scroll thru the various menu items. 
With the desired menu item displayed, press the up or down arrow key to select the state. 
When the desired state is displayed press the select key to input the menu item and state. 
The menu items are: ACCL, CAd, diA, FILL, indE, JOY, OPEr, and Set.

Menu Items:
ACCL allows setting the acceleration in ¼ G increments.  Acceleration is the rate of 
increase/decrease of speed of the motors along a vector.  Higher G values increase 
throughput however higher G values also increase the likelihood of experiencing 
repeatability problems.  Recommended values are (2-8) for standard labels.

CAd override menu function enables or disables the CAD override function.   This is an 
advance function and is only necessary when using cad systems that are not designed for 
the AXXIS.  With the function On the AXXIS will ignore some HPGL control 
commands sent from the cutting software.  With the function Off the CAD software can 
control these HPGL commands.  

The commands affected by CAd override are:
AS set acceleration
FS set force
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KA set minimum angle
KN set knife offset
IP input P1/P2
RO rotate
SC set scale
SP select pen
ST select tool
UV up velocity (move speed)
VS down velocity (cut speed)

Press the select key to initiate the menu function. Press the left or right arrow key to 
display CAd, then press the up or down key to toggle between off and on. Press the 
select key to lock in the desired menu setting.

diA is used for entering into the diagnostic mode.  Press the select key to initiate the 
menu function, then press the left or right arrow key to display diA. Press the up or down 
key to scroll thru the diagnostic numbers (0002 – 0099).  Press the select key to start the 
diagnostic. (see diagnostics section) .  To exit from a diagnostic mode select 0099 and 
press select.

FILL is used to add more material to the supply accumulator loop at any time during the 
operation of the AXXIS.  Press the select key to initiate the menu function, then press the 
left or right arrow key to display FILL.   Press the select key and the AXXIS station 
will pause and the supply nip roller drive will start to fill the supply dancer bar loop. 
Once complete the supply nip roller drive will automatically stop and the AXXIS will 
resume.  This is useful if for some reason either of the dancer bar loops have insufficient 
material.  

IndE indexes the x-axis.  One of the uses for this function is for metering material. 
Press the select key to initiate the menu function, then press the left or right arrow key to 
display IndE.   Press the select key.  Press the up or down arrow to toggle between 
inches (InCH) or centimeters (cEnt).  When the desired unit of measure is displayed 
press the select key.  The display will read 0001. The number represents the number of 
inches or centimeters to be metered in the x-axis. Increase the number by pressing the up 
arrow key of the joystick.  Hold the key down and the numbers will start moving slowing 
then more quickly.  Press the down arrow key to lower the number.  Alternatively the 
force keys will increment the single digits and the speed keys will increment the 10’s 
digits.  Input the length and start by pressing the select key.

JOy allows changing the joystick parameters: of jog distance or slew speed.  Press the 
select key to enter the menu system.  Press the left or right joystick buttons until JOy is 
displayed.  Press up or down on the joystick to select (Sped or Jog).  Press select.  Press 
up or down on the joystick to select a value for joystick speed (1-100%) or jog distance 
(0.01 inch increments).  Press select to save the displayed value.

This menu item has 2 sub-menus:

• Sped- Allows the user to set the maximum speed that the joystick will move the 
material or head when pressed twice. Range 1-100.
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• Jog- Allows the user to set the distance that the head or material will move when 
a joystick button is pressed and released. Range is 1-100 in 1/1000th inch 
increments. 

i.e., 1 = 0.001”, 100 = 0.100”

OPEr is used to select the operation mode between cutting (CUt), pen plotting/drawing 
(drA) or pouncing (POUn).  Press the select key to initiate the menu function, then press 
the left or right arrow key to display OPEr. Press the up or down key to select the desired 
function.  Press the select key to lock the desired menu setting. 

SEt loads or saves a custom set-up or power up default. Press the select key to initiate 
the menu function. Press the left or right arrow key to display SEt. Press the up or down 
key to scroll thru (LOAd, Save), press select, press the up or down key to scroll thru the 
settings (1 – 6).  Press the select key to load or are save the setting.  Setting #1 is loaded 
when the machine is powered up.  (see also factory and custom set-up section) 

The set menu item has 2 sub-menus:

Load- loads a setup.

To load a setting  :  

• Press select
• Press left or right arrow until SET menu is displayed. 
• Press up or down arrow to display Load.
• Press select
• Press up or down arrow to display the number of the setting you want to load (1-

6)
• Press select.

Save- saves a customized setting.

To save a setting:

• Adjust force, speed, acceleration as needed. 
• Press select 
• Press left or right arrow until SET menu is displayed. 
• Press up or down arrow to display Save.
• Press select
• Press  up  or  down  arrow  to  display  the  number  of  the  setting  you  want  to 

customize (1-6) (# 1 is the setting that is loaded on power up.)
• Press select.

4.9.6.9 Mandrel Switches and Controls
On the right of the control panel are four switches.

TAKE-UP MANDREL controls whether the take up motor will turn.  You will need to 
turn this motor off during loading and on during operation.

WEED MANDREL controls whether the weed motor is on or off.  You will need to turn 
this motor off during loading and on during operation.
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LAMINATION MANDREL controls whether the lamination mandrel will supply 
media to web.  Turn off if you are not laminating or loading.  Turn on for laminating.

SUPPLY MANDREL controls whether the supply mandrel will supply media to web. 
Turn off during loading.  Turn on while in use.

TAKEUP TORQUE In addition there is also a knob on the right side of the front panel. 
This controls the speed and the tension on the takeup mandrel.  Clockwise turning 
increases tension and speed of takeup mandrel.

5 Maintenance & Consumables
5.1 B500 Printer (refer to Epson Manual)
5.1.1 Substrates
The Epson B-500 uses Epson DURABrite ink, which is a water-based ink. It is 
recommended that all substrates are coated with an ink jet compatible coating.

5.2 i-TECH AXXIS Finisher
5.2.1 Changing a blade
The knife blade should be replaced when the force has been increased by more than 20 
percent or the cut quality has degraded.  The first sign of blade degradation usually 
occurs in the corners of the cut and may lead to poor weeding.  

New blades slide into the holder to a preset height and are held in magnetically. No tools 
or adjustments are required.  To replace the blade, first remove the blade holder from the 
tool holder by loosening the brass thumbscrew and pulling up on the silver knife holder. 
Remove black plastic cap.  To remove the used blade, grasp it with a pair of tweezers and 
pull it out of the knife holder (discard the blade safely).  Remove the new blade from the 
plastic case and remove the protective cap.  Insert the blade into the holder and let the 
magnet pull it into the preset position.  Install plastic cap.  Reinsert the knife holder into 
the tool holder and tighten the brass thumbscrew.

Replacement blades are available from several sources including from Allen Datagraph 
Systems, Inc.  They can be purchased online @ http://www.allendatagraph.com/ or by 
calling 603-216-6344.  

H20-017 30° Allen Datagraph i-TECH, DFS, Centra, Axxis cutting blade.  Ideal for label 
stock. Angle of blade at 30 degrees to have exact control on depth of cut.  This blade has 
a 0.012 inch (0.0305 cm) offset.  It can be identified by its blue plastic cap.

H20-007 45° Allen Datagraph i-TECH, DFS, Centra, Axxis cutting blade.  Ideal for 
general purpose cutting of vinyl and other thin materials. Angle of blade at 45 degrees to 
balance depth of cutting and pivot angle.  This blade has a 0.012 inch (0.0305 cm) offset. 
It can be identified by its red plastic cap.

H20-008 60° Allen Datagraph i-TECH, DFS, Centra, Axxis cutting blade.  Ideal for 
cutting thick materials. Angle of blade at 60 degrees to optimize cut angle.  This blade 
has a 0.012 inch (0.0305 cm) offset. It can be identified by its green plastic cap.
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Tool Holder Block

The knife blade holder is installed in the tool holder block with a thumbscrew. The tool 
holder block is held to the cutting head by two hex drive screws.

Knife blade holder Assembly
The blade holder is designed for use with Allen Datagraph’s 30°, 45° and 60° blades. 
Solvents and lubricants should not be used, as they will diminish cutting accuracy. 

Knife Blades 
Knifes blades for the Allen Datagraph AXXIS Unit are made with tungsten carbide and 
are designed specifically for digital die cutting. The tip is offset from the center of the 
shaft so that the blade has a caster action when pulled. Blades are available in 30, 45 and 
60-degree tip angles. The 60-degree is intended only for thick materials such as sandblast 
mask or thick over-laminates.  For best cutting results, protect the knife tip from damage 
when not in use. 

Knife Blades Depth Guide  
Allen Datagraph's controlled depth knife holder has a depth guide that is adjustable to 
control the depth of cut the AXXIS makes.  Normal materials do not need to use the 
controlled depth adjustment and the black plastic cap can be screwed in completely to 
expose the blade.  Material with insufficient backing may require the use of the 
controlled depth cap.  Correct adjustments allow the blade to cut the material and lightly 
mark the backer (carrier) material. Too much cut depth can cause cut through and 
premature blade wear.  Not enough cut depth will make "weeding" of media difficult. 

Use the cut test, force and depth adjustment to establish good cutting (see setting cut 
force – cut depth section)

5.2.2 Changing a cut strip
Clean any debris from the groove before installing the groove filler. The filler simply 
snaps into and out of place with no special tools required. It is important that the 
groove filler be installed fully and evenly, otherwise material cut through may occur 
in some sections across the cutter. The groove filler should be installed for knives and 
pen plotting, but must be removed for Pouncing
Two different cut strips are available from the http://allendatagraph.com online store. 
Normal life (DF-310) and extended life (DF-410) cut strips.

5.2.3 Cleaning
The regularity with which the cutter needs to be cleaned is dependent on the usage, as 
well as the climate and contaminants in the cutter’s environment. It is recommended that 
the following cleaning steps be done at least as often as indicated for each procedure:

• Biweekly. Clean the three grit wheel surfaces with a stiff bristled e.g. tooth (not 
wire) brush to remove any media particles that may have built up during cutting. 
Brush the surface of the grit wheel while turning the grit wheel by hand so the 
entire surface of the grit wheel is cleaned. CAUTION: Be sure to disconnect the 
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cutter from the power source while cleaning the unit. Keeping the grit wheel clean 
is important so the cutter will hold the media accurately.

• Biweekly. Wipe media-related dust from the set of polyurethane pinch wheels by 
using a soft cloth.

• Monthly. The outer surfaces should also be kept clean. If necessary, a mild 
cleaning solution on a damp cloth can be used to gently wipe the surfaces clean. It 
is suggested that a mild soap and water be used with a soft cloth. This solution 
works well on all painted surfaces. CAUTION: Do not use any abrasive cleaners, 
as they will cause the paint to blister.

• Yearly. Inspect the internal circuit board assemblies and clean accumulated dust 
as necessary. Be certain that the cutter power is off. Observe static discharge 
safety procedures that may damage sensitive electronic components. Wear a 
grounding strap connected to earth ground. Wear safety glasses to protect eyes. 
Remove rear cover and use compressed air to remove dust and debris. Replace 
cover to original location and make certain that the boards and any connectors are 
well seated.

5.2.4 Pinch Wheel Maintenance
Pinch wheels are critical to the AXXIS unit's material handling performance. They 
should be inspected for wear regularly and cleaned as needed. To clean adhesive off the 
pinch wheels, simply use a soft cloth and denatured alcohol.

In normal use, the pinch wheels will need to be replaced in time. Also, trying to move 
them when they are in the down position can damage them. If material does not track 
well and guide alignment has been verified, the pinch wheels may need to be replaced. 
For best tracking results, replacement pinch wheels should be replaced as a SET. 

To check condition of pinch wheels:
Inspect condition of rubber The rubber wheel should not have any cracks and should be 
securely adhered to the aluminum hub of the wheel. The transition from the flat surface 
of the wheel to the "sidewall" edges of the wheel should be sharp and not rounded.

Inspect integrity of pinch wheel bearing This is done by having the pinch wheels in the 
up position. Spin wheel with finger and observe whether the bearing has a dry sound or 
not. If it appears to be dry, the wheels should be replaced.

Pinch wheels (p/n PL-00-02-062) can be ordered from the online store at 
http://allendatagraph.com 

5.2.5 Mechanical Adjustments
Belt Tension
The AXXIS servomotors use timing belts to control the material (X axis) and tool (Y 
axis) positions. The belt tension and wear should be inspected if cut quality deteriorates. 
To inspect the belts, remove the back of the AXXIS.  This can be done by removing 
about 4 large screws along the edge of the rear cover.  (see also TSB: Mechanical 
Adjustments to Restore Cut Quality to Normal Web Site Copy / CD Copy)
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Y-Axis

The Y-axis short belt runs between the Y-axis servomotor and a gear assembly. To adjust 
the tension of this belt, it is necessary to reposition the motor bracket. 

• Open the back cover (6 screws)

• Loosen the three Phillips head motor bracket screws and apply hand pressure to 
tighten the belt so that the belt will deflect 0.050 inches at the center when 23 
ounces are applied. (1.3 mm when 660 grams are applied).

• When the belt is tight and the motor shaft is parallel to the bearing shaft, tighten 
the three Phillips head motor bracket screws. Premature belt failure will occur if  
these two shafts are not parallel.

• Verify tension. 

• Close back cover.

The long belt is adjusted using a lead screw located behind the control panel. 

To set the long belt's tension:

• Position the carriage to the far side.

• Remove the control panel housing as follows

• Remove the Allen screws that hold on the cover for the LCD display.

• Loosen the locking nut.

• Adjust the lead screw so that the belt will deflect 0.125 or feels taut.  You can 
also pluck it like a string and is should make a low tone.

• Move the carriage slowly from two or three inches/cm front and back to 
equalize tension on pulleys.  Check tension again. 

• Set the lead screw lock nut.

• Verify belt path and tension.

• Replace the control panel housing, top rail cover and rear cover.

X-Axis

• Open back cover

• The belt inside the rear cover drives the grit wheel (X axis). To adjust the tension 
of this belt, it is necessary to reposition the motor. 

• Loosen the two motor bracket screws and apply hand pressure to tighten the belt 
so that the belt will deflect 1/16 inch at the center when 23 ounces are applied. (2 
mm when 660 grams are applied). (Replace belt if damaged or worn). 

• When the belt is correctly tensioned, tighten the two motor bracket screws.

• Verify belt path and tension. Check that the large gear turns freely.

• Close back cover
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11.12 Troubleshooting i-TECH AXXIS Finisher
Problem Solutions
Cutter does nothing • Panel lights off, no fan noise : plugged in, power on, cycle 

power
• Check fuse replace with one 5A for 115 vac or two 2.5A 

for 220 vac.
• E-Stop button pressed.

Cut through/poor 
weeding

• Is  your  knife  blade sharp?   You can check condition  of 
blade by examining the blade tip under a 30x microscope. 
The blade tip must be present.

• For very thin (less than 0.002 inch, (0.05 mm)) or liner less 
than 20 lb. media you might need to use the controlled 
depth adjustment on the end of the knife holder.  Partially 
unscrew the black cap until just enough knife blade is 
exposed to cut through the media but not the backer.  Test 
by drawing knife across media by hand.  You can then use 
a higher force with no cut through.

• It is important that the groove filler be installed fully and 
evenly, otherwise material cut through may occur in some 
sections across the cutter.

• Insufficient backer weight.
• Check mechanical adjustments Website Copy / CD Copy
• Increase / Decrease force.  Increase decrease knife offset.
• Check cut strip condition.  Replace or reverse if damaged.
• Decrease acceleration or speed.
• Increase resolution in printer driver.
• Do not allow cutter motors to pull media off of roll.
• Using wrong angle of blade for material.
• Not tracking.  Fix this first.

Images are incorrect 
size

• If error is small (< 1/2 inch (12 mm)) make sure grit wheel 
is clean.  Dirt build up in grit will change the size of the 
grit wheel making it cut the wrong size.  Run diagnostic 07 
to calibrate the cutter to a ruler or a printer as desired.  

Contour cuts are wrong 
size.

• If you are using origin only or origin skew no scaling is 
done to image received.  In this case you must calibrate the 
cutter to your printer rather than a ruler.  You do this by 
printing a  large rectangle on your  printer.   Then cut the 
same size rectangle.  For x and y drawn use printed size 
rather than a ruler as drawn or desired size.

• If you are using origin scale, or origin skew scale then the 
size of the cut is change by the x or y sensor size parameter 
in the line sensor menu.

• See SmartMarkTM setup in Appendix A
Labels or contour cuts • Verify you created job correctly.
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are cutting in the wrong 
spot • Origin Target is at minimum x and maximum y of drawing.

• The scan area contains only target and background with no 
stray marks that could be seen as targets.

• Verify printer properties are correct

• Rotation is set correctly.  Target cut should be in same 
corner on preview as selected origin corner.

• Find origin property is set to Origin only.

• Verify sensor settings have not been lost

• In the remote panel select setup -> line sensor menu.

• Verify x sensor offset is about 0.75 inch and y sensor offset 
is about –0.1 inch

• If your job is off by only a little bit (less than 1/8 inch 
(3mm)) and is same for every frame you can measure this 
error and correct your x and  y sensor offset by the amount 
of the error you measure.

• Verify scan length is the same as the length of the side of 
the target

• Verify the scan offsets = ½ of the length of the side of the 
target

• Verify the Scan Velocity is either 1 or 2.

• Verify the space between jobs in the line sensor menu is 
zero.

Target errors tar1, tar2, 
tar3, tar4

• These errors indicate that the target scanner did not find the 
target.

• If tar1 on first frame:

o Verify that you positioned red led pointer to right 
rear corner of target

o Verify red led is lit.

o Check that distance led is from media is 3.4 to 4.6 
mm.

o Run line sensor diagnostic (21) to verify operation 
of sensor.

• If tar1 on 2nd or subsequent frame

o Verify space between jobs in printer driver is set 
correctly.  If it is set correctly after cutting first 
frame the knife blade should be on the right rear 
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corner of target of next frame.

• Tar2 – 4.

o Verify job you are sending matches job you printed

o Verify rotation is correct in printer driver

o Verify job is built correctly in that scale and skew 
target print is in same location is die lines for scale 
and skew target.

o Verify scale and skew targets are at extents of 
image.  Skew should be a minimum x and 
maximum y.  Scale target should be at maximum x 
and minimum y.

No action when you 
send data to cutter

• Allen  Spooler:  If  plot  is  sent  from computer  and  cutter 
doesn’t cut, check for Allen spooler in the task bar (Lower 
right of monitor, green box with red arrow, near time). If it 
is  not there,  go to start  button,  programs (all  programs), 
startup, Allen spooler and click on Allen spooler. If you get 
message saying Allen spooler starting with one job left in 
queue, cancel it and send job again after checking to see 
that cutter is ready.

• Click on red arrow in green field icon in service icon area. 
If you are getting unable to open port displayed 

• See if remote panel still has port open.  It should auto close 
the port after 5 seconds.

• Reboot computer  and power cycle  cutter,  cancel  all  jobs 
and try send job again.

• Verify port selected is correct.  You can find the correct 
port from the device manager.

• Plug usb  cable  into  same  usb  port  as  you  normally  do. 
Different  usb  holes  are  normally  configured  as  different 
com ports.

• Rerun  enable  printer  driver  to  find  cutter.   Start  >  All 
Programs  >  Allen  Datagraph  >  Cutter  Driver  >  Enable 
printer driver

• Try different usb cable or different computer.
• From spooler cancel all jobs, turn cutter off/on and resend 

job.
• No usb driver installed for equipment  Website Copy /  CD 

Copy
• Cutter in pause state.
• Make  sure  cutter  and  computer  are  plugged  into  same 

outlet if using usb.
 Job does not complete • Verify minimum cutter driver level of 2.08g.  New 

software can be downloaded from Web Site Copy
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• If you have less the firmware revision 12 as usb version in 
your cutter turn off polyline encoded output in printer 
properties, device settings. Web Site Copy / CD Copy

• Try a different cable or computer
When I turn my cutter 
on, the head reaches the 
side plate and makes a 
loud noise

• Loose long Y belt

if carriage is getting to the right side and making a 
ratcheting noise, it's could be the long y axis belt, or the y 
axis motor belt located under the left control panel. To 
determine which belt it is, turn the machine on while 
holding out on the long belt that attaches to the cutting 
head. What this does is put more tension on the belt. If the 
head gets to the side and they don't hear the noise, proceed 
to below: 

Remove the front control panel and locate the belt 
tensioner. This is a wedge-shaped device with a long 
Phillips head screw protruding toward the rear of the 
machine.

Loosen the 3/8" locking nut holding the tensioner screw in 
place. Turn the Phillips screw a couple turns clockwise, 
then turn the cutter on before attaching the control panel. If 
the cutter initializes, there is no need to look further. If this 
does not solve the problem, proceed to the next step: 

Open rear cover, turn cutter on and observe the belt 
attached to the motor. If the motor pulley continues to turn, 
then the short motor belt is most likely either loose or worn 
out. Carefully inspect the teeth on the belt for wear with the 
machine off. The pulley can be rotated to allow inspection 
of teeth.

• If the teeth are not worn or stripped off the belt, loosen the 
three  mounting  screws  holding  the  motor  bracket  to  the 
sideplate. Apply tension to the motor bracket BY HAND, 
and tighten the screws. The belt should have less than 1/8” 
of free play when properly tightened.

Router keeps changing 
my ip address

• Some routers do not keep a table of mac addresses so that 
the same computer will be assigned same ip address each 
time you power up.  In this case run diagnostic 4 and 
assign a static ip address to the cutter.  See also Website 
Copy / CD Copy    or    Website   Copy   /   CD Copy  

Material Does not track 
straight

• Inspect pinch wheels
• Clean grit wheel and pinch wheels.
• Reduce acceleration and / or velocity.
• Insure cutter is loaded straight.  Same distance from back 

wall from supply to takeup.
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• Perfect leveling is not required in steps below but 
adjustments need to be close.

• Machine loaded per Web Site Copy / CD Copy.

• Machine Level (place level on cut strip) level with machine 
/ table legs.

• Adjustable bars level.  Set level on Web guide 3, exit roller 
and adjust until level.

• Mandrels Level (to adjust remove back of machine and 
loosen 4 mandrel leveling bolts.  Align with Square. Check 
with level.  Tighten bolts.)

• Skewing

• Verify both front and rear dancer bars are not bouncing on 
bottom or top of service loop.  Bouncing will cause the 
media to slip between the grit wheel and the pinch roller.

• See also solution to Accumulator hits bottom causing 
tracking error and / or  missed targets

Lamination Not 
Tracking

• Machine loaded per Web Site Copy / CD Copy  .  

• Machine Level (place level on cut strip) level with machine 
/ table legs.

• Printed media must be wound on core evenly

• Laminate same width or smaller than printed stock. 
Laminate with should be 1/16” to 1/8” smaller than printed 
stock.

• Too much pressure on laminate roller (blue rubber roller). 
Only a light pressure is required on laminate roller.

• Uneven pressure on laminate roller.  To set pressure loosen 
two nuts on each pressure control.  These are the hinged 
cam latches that supply the pressure on the blue roller.  To 
measure the pressure you need to create two sandwiches of 
three pieces of the unlaminated printed media.  Place one 
sandwich under operator side latch and one under gear side 
latch.  Adjust the pressure the latch applies to the blue 
roller until both centerpieces of the sandwiched media can 
be pulled with the same amount of force.  Test tracking. 
After laminate tracking works correctly tighten lock nuts.

• Mandrels not perpendicular to back plate.
Accumulator hits 
bottom causing tracking 
error and / or  missed 

• For units shipped after 5/1/10. See Web site copy / CD 
copy
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targets

 Appendix A – i-TECH remote panel Advanced Options
 A.1 Enable Advanced Options
To enable advanced options select setup -> options from remote panel. Change 
advanced/normal menu options to advanced.

 A.2 Action Menu
 A.2.1 Send HPGL File
Send HPGL File will send a HPGL plot file directly to the Axxis.  Typical origins of 
HPGL files include the Allen Driver, CorelDraw or some other design software.  To send 
a HPGL cutter file from the remote panel program click the Send HPGL File menu item 
to open the select file window.  Select the files desired and click the Open button.  This 
will send the file directly to the Axxis.

 A.2.2 Cancel, Continue, Pause
These commands will cancel, continue, or pause a job being sent by the Send HPGL 
command.  For jobs sent by other programs you can use the Pause button on the AXXIS 
and the (F1, F2, F3) combo to cancel the currently cutting job.

 A.2.3 Open Com Port 
Opens a communication channel to the Axxis and sets a long timeout for close.

 A.2.4 Close Com Port
Closes communication port to cutter.  Since only one program can talk to cutter at a time, 
selecting this command allows other programs to talk to Axxis.  The remote panel will 
normally automatically close the com port after a period of inactivity.

 A.2.5 Upload Firmware
The firmware on this disk is provided for update purposes only and should not be  
installed on new machines.  In general you should not install a firmware update unless  
directed by a member of the technical support staff.  Firmware updates are available on 
the technical support page of the Allen Datagraph web site at  
http://www.allendatagraph.com.
This procedure details the firmware upgrade procedure.  Normally firmware is only sent 
to customers when a software problem is reported that has been fixed in a later version of 
the software.
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From time to time Allen Datagraph will recommend that you upgrade your firmware in 
your Allen Datagraph Axxis.  A file 
can be downloaded from the Allen 
Datagraph web site and saved to the 
desktop.  

Before running the setup program be 
sure to exit the older version of the 
Remote Panel.

A.2.5.1 Firmware Installation 
Instructions:

Turn off your equipment.  Press the 
load button on your front panel and 
then, turn on the Allen Datagraph 
equipment to be upgraded.  Start the 
Remote Panel by clicking on start, 
program, Allen Datagraph, Remote Panel.  Click on Setup, Com Port and verify that the 
correct port has a check next to its name.  Click on Action, Upload Firmware.  If asked, 
select pic32rel.hex file and click Open. If the upload fails, you will be given a backup 
procedure to follow on the computer screen.

 A.2.6 Save to EEROM and Restore from EEROM
This procedure allows saving the eerom and restoring it when certain hardware is 
replaced.

 A.3 Setup Menu
These commands are used to save custom settings and factory settings to the computer 
when certain electronic components need to be replaced.

 A.3.1 Main Menu
Knife Settings Tab

 The AXXIS will also self adjust the speed within certain limits based on the speed of the 
device feeding the unit.  The range for speed is 1 to 100%.  Enter min and max speed 
for Label Mode and check the Allow Speed Change.  This option is only useful in 
alternate hardware configurations.  Not support on standard Axxis model.

Hole Distance and Tear Size are used when the AXXIS is in the Pounce Mode.  The hole 
distance setting is the distance between holes and the tear size is the distance the AXXIS 
moves with the pounce tool down to tear the media and enlarge the pounced hole

The Rubber tab 

Rubber Scratch Force displays and sets the down force used during tangential emulation. 
This is primarily used when cutting thick materials such as sandblast rubber.  Tangential 
emulation simulates a tangential or servo controlled rotating knife by moving to a 
position short of the vector to be cut and putting the knife blade down with a very light 
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force while moving toward the direction of cut to align the knife before applying the full 
cutting force.  This improves the cut quality in thick materials.  (default 0.1%)

Rubber Backup Multiplier (default 20) displays and sets the distance the knife will be 
dragged at the light force used to align it.  This parameter is used with and is additive to 
the Rubber Backup Offset (default 0.02).  The Rubber Backup Multiplier is based on the 
change of angle between vectors and the Rubber Backup Offset is a constant added to the 
distance calculated based on angle.

Rubber Minimum Angle (default 19) is the rotation angle between two vectors that 
enables tangential emulation.  Subsequent vectors that have angle between them 
exceeding this parameter cause the pen to be picked up, dragged along the surface to 
align the knife and plunged into the media at the beginning of the next vector. 
Subsequent vectors that have angle between them less than this parameter will perform a 
drag rotation.

Max Motion Vector Length (default 0.001) (Named after the driver that outputs very 
small vectors) Allen AXXISs very accurately replicates the vectors in the HPGL plot file. 
Some design programs output vectors that are very short.  It is sometimes desirable to 
combine some of these vectors into a longer vector to eliminate jagged edges or slow 
cutting.  This parameter works like a curve-smoothing algorithm and is used to improve 
poor HPGL files.

Anticipation Rubber (default 0.001) and Anticipation Vinyl (default 0.0004) is a parameter that 
adjusts the backlash compensation in the AXXIS.  The Anticipation Rubber is the 
parameter used when the AXXIS is in tangential emulation mode and the Anticipation 
Vinyl is the parameter used when not in tangential emulation mode.  Heavier materials 
require more backlash compensation.  These numbers are individually set at the factory 
and should not require adjustment except when cutting heavy materials.  If you are 
experiencing thick and thin lines or misshaped letters, adjust the anticipation parameter to 
obtain satisfactory results.

 A.3.2 Setup -> Line Sensor Skew tab
Y Target Location.  This is the distance between the origin target and the skew target 
when the 2nd parameter  of the FO command is  –1.   This command is  used on CAD 
systems that do not emit the FO HPGL command.  You set up the initialization string to 
have 

BJ1;FO-1,-1; <for origin skew and scale processing>

or

BJ1;FO0,-1; <for origin and skew processing>

This causes the AXXIS to look at the Y Target Location parameter from this menu item.
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 A.3.3 Setup -> Line Sensor Scale tab
X Target Location.  This is the distance 
between the origin target and the scale target 
when the 1st parameter of the FO command is 
–1.  This command is used on CAD systems 
that do not emit the FO hpgl command.  You 
set up the initialization string to have: 

BJ1;FO-1,-1; <for origin skew and 
scale processing>

This causes the AXXIS to look at the X 
target location parameter from this menu 
item.

 A.3.4 Setup -> Settings
Dynamic Force engages the dynamic force 
function that instantaneously adjusts the 
force on the fly based on the actual velocity 
of the knife blade.   All AXXISs must 
accelerate and decelerate as they cut around corners.  Some medias require different force 
settings for different speeds.  This parameter allows for building a database for these 
materials and when enabled will greatly improve the cutting on these materials. (See the 
Setup → Dynamic Force  for more details)

Coordinate System

Allen Systems have four origins to allow for flexibility when using various CAD/CAS 
systems.  The AXXIS is shipped with the Long X coordinate system in all factory set-ups 
and is compatible with most cutter or printer drivers.  The choice of coordinate systems 
other than Long X is beyond the scope of this document.

 A.3.5 Setup -> Options
Menus option offers the more advanced 
features of the software.  It is 
recommended this be set to Normal 
until a more advance feature is 
understood or is required by your 
operation.  The menu items below are 
displayed when the menus is set to 
Advanced.

Autocad OH Command determines 
how the system will respond to the 
HPGL OH command. 

Expand Mode allows the AXXIS to cut past the normal clip limits in the Y-axis.  This 
function allows cutting and extra 1/2 inch wider (12 mm).
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High Resolution Force sets the force resolution to 1 to 1000 steps instead of 1 to 100 
steps.  It is useful when cutting very  hard to cut medias.  It allow setting the force 
between two of the standard force settings.  A force of 112 is equivalent to 11.2 % force. 
(also see the Setup → Dynamic Force )

Joystick Knife Offset this option controls whether the cutting data point includes or 
excludes the knife offset.  The normal setting is exclude.  Include is used for CadLink’s 
Signlab program when digitizing only.  You should use exclude for all cad systems 
except Signlab.

 A.3.6 Setup → 
Dynamic Force 
This  feature  is  considered 
an  advanced  feature  and 
does  not  appear  on  the 
Setup menu unless the menu 
is  set  to  advanced  on  the 
option  page.   Dynamic 
Force  allows  different 
forces  to  be  applied  at 
different velocities.   Adjust 
sets  up  the  dynamic  force 
parameters  and  database. 
To establish a new material database type in the name of the new material in the Material 
Selection box and click  Add.  In the Force and Velocity Window, type in the desired 
force vs. velocity that you have established for the material.   The recommended method 
for establishing the various force vs. velocity numbers is to run the test cut at various 
velocities and record the results for entry here.
Enter the Maximum cut speed for the media in the Max Draw Speed window.
Before using Dynamic Force Adjust, it is necessary to send the force setup to the cutter 
memory by clicking the Send Force to Cutter button.

 A.4 Diagnostics
The Axxis firmware contains a set of resident diagnostics. When the Axxis is powered 
up, it automatically performs a self-test program to check all operating parameters. If a 
malfunction is detected, the letter “E” and a three-digit error number will be displayed in 
the display window. The error numbers and the corresponding malfunction descriptions 
are given in the error code appendix B. When an error is displayed and no obvious 
damage was done to the Axxis, power off the Axxis and repeat the procedure that caused 
the error to display. If the error reoccurs, the user may push any key on the control panel 
to enter the diagnostic mode. Many errors automatically place the Axxis in the diagnostic 
mode when a key is pressed. 

The fail-safe system is designed to detect failures in the operation of the 
electromechanical system in the Axxis and to prevent such failures from causing other 
damage. The Axxis monitors motor currents and will generate an error if motor current 
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too high or unmeasureable.  It also generates an error for impossible or dangerous 
conditions.  The appropriate error code will appear, as mentioned above, in the display 
window on the control panel.

The diagnostics in the AXXIS exist at several levels: 
1. POWER-ON
2. CONTINUOUS HARDWARE AND SOFTWARE MONITORING
3. OFF-LINE

The POWER-ON diagnostics are performed at power-on or reset of the microprocessor 
and test the microprocessor, memory, servo analog and digital hardware, and some of the 
testable sensors. 

After initialization, CONTINUOUS HARDWARE AND SOFTWARE 
MONITORING check the sensors and fail-safe monitors for machine malfunctions. If a 
malfunction is detected, an error code is displayed on the control panel display, motors 
are shutdown and the Axxis ceases operation. 

OFF-LINE testing is used for manufacturing and field service testing and for making 
certain adjustments to the AXXIS such as calibration. 

To Run Diagnostics if the AXXIS unit is displaying an error code on the front panel 
display, press any key to enter the diagnostic mode.

 A.4.1 How to run Diagnostics
A.4.1.1 From Front Panel
Turn unit on and allow initialization to complete. If the AXXIS is displaying a flashing 
error code on the front panel display, press any key to enter the diagnostic mode.

Press the select key to initiate the menu function, Press the left or right arrow key to 
display diA. Press the up or down key to scroll thru the diagnostic numbers (0002 – 
0099).  Press the select key to start the diagnostic. 
TO STOP A DIAGNOSTIC

Press the reset key sequence F1, F2, F3.
TO EXIT THE DIAGNOSTIC MODE 

To return to normal operation, run diagnostic 99 or cycle the AXXIS power off and on

A.4.1.2 From Remote Panel
To start diagnostic select diagnostic to run from diagnostic pull down menu in the Axxis 
remote panel.  Follow on screen directions.  To stop a diagnostic press the CTRL-C 
character on the keyboard or turn off and on the Axxis.

 A.4.2 Setup Diagnostics
A.4.2.1 Setup/Operation of Switch or Analog Accumulator Sensors
A.4.2.2 Setup/Operation of Switch or Analog Accumulator Sensors
At load or beginning of frame
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  Turn on takeup and supply motor for enough time to empty/fill accumulators

While idle and ready (load led on)

  If input/output accumulators are < / > half full turn on supply/takeup motors to make 
accumulators 1/2 full.  

While cutting

If input accumulator < 1.4 inches of media or output accumulator > accumulator length – 
2.4 inches of media then pause cutter.  If stepper motors are off turn on stepper motors ½ 
inch of movement

If paused by above and input accumulator has more than required amount of inches turn 
on steppers for ½ inch movement.

At end of job center accumulators.

At beginning of copy move to load position before starting copies.

A.4.2.3 Switch Sensor Operation
Uses diagnostics 55 and 45

At load fills input dancer until bottom sensor is hit.

At beginning of frame turns on both steppers to advance last frame size distance

Uses state machine to decide what steppers to turn on and when. 

A.4.2.4 Diagnostic 39 Set Input Accumulator Stop Position
Diagnostic 39 allows setting the Input Accumlator Stop Position in inches of media in the 
accumulator at beginning of frame.  The range of values is 0.8 to 8.0.  If your input 
accumulator hits bottom during operation make this value larger.  If it rides up too high 
you can reduce this number.

A.4.2.5 Diagnostic 40 Set Accumulator Length
Diagnostic 40 allows setting Analog rail length set to 2 times the distance between top 
and bottom of movement available.  We use 17.5 inches on Axxis.

A.4.2.6 Diagnostic 41 Display Input Accumulator Position
Diagnostic 41 displays the current ADC value and position.  The values change from 
position that has a decimal point to adc value which does not.  The position information 
requires that diagnostic 44 be run. See also Diagnostic 44 Map Accumulator Position

A.4.2.7 Diagnostic 42 Display Output Accumulator Position
Diagnostic 42 displays the current ADC value and position.  The values change from 
position that has a decimal point to adc value which does not.  The position information 
requires that diagnostic 44 be run. See also Diagnostic 44 Map Accumulator Position

A.4.2.8 Diagnostic 55 Set Accumulator Type
Diagnostic 55 allows setting sensor type for accumulator.  Default is fill.  Set to AnLg if 
analog sensors are installed or Fill for switch sensors.
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A.4.2.9 Diagnostic 45 Set Stepper Speed
Diagnostic 45 allows setting speed of stepper motors.  Time steppers by timing the 
feeding of 36 inches of media.  The divide 36 by the time measured.  Enter this number. 
On Axxis this number should be about 3.5 inches per second.  If unit shipped before 2-
15-10 measure speed and enter that number here.  See also Web site copy / CD copy

A.4.2.10 Diagnostic 44 Map Accumulator Position
If you have analog sensors you must map the sensors since the transducer is not linear. 
Diagnostic 44 allows mapping the non-linear position of the analog position to adc 
values.

Before running diagnostic check operation of the adc.  Do this by removing media and 
running diagnostic 41 for supply sensor and 42 for takeup sensor.  Display will oscillate 
between the position and the adc value.  The position value will not be correct until 
completing this diagnostic.

The top adc value should be in the range of 1-50 adc counts.  You do this by making the 
plunger for the sensor just slightly push in the plunger.  You change this by either 
rotating the block on the bar or moving the top of the diagonal toward or away from the 
sensor.

The bottom adc value should be between 600-750.  If you have a larger value the plunger 
is probably bottoming out.  You fix this by moving the bottom of the diagonal away from 
the sensor.

In order to load media on a machine on machine that has never run diagnostic 44 you 
have to turn off label mode with diagnostic 64 = off.

To run diagnostic load media between supply nip, through pinch wheels and output nip. 
Accumulator dancers should be within 1/8 inch of the very bottom on the supply side and 
within 1/8 inch of the very top of the takeup side.   The pinch wheels should be down. 
Start diagnostic 44.  The adc values for input and output accumulators oscillate.  One 
number should be between 1 and 50 and the other between 600-750.

Press select.  run is displayed.

The grit will advance media 1/8 inch at a time recording adc value for each 1/8 inch 
position.  At the end of the diagnostic 44 good or bad is displayed.

If good press select and then run diag 64 to turn label mode on if you turned it off before, 
then diagnostic 41 and 42 to verify top, bottom and middle positions displayed.  Top 
should display 0.00 inches bottom should display number set in diagnostic 40 above. 
Middle should display about 1/2 this number.

If bad is display the starting value is > 255 or the bottom value – top value is < 100 adc 
counts.  Fix mechanical or electrical problem and try again.

Exit diagnostic by pressing any button on the front panel.

A.4.2.11 Calibrate 07
See calibration procedure at Website Copy / CD Copy  available on the technical support 
page of the Allen Datagraph web site at http://www.allendatagraph.com.  
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A.4.2.12 Calibrate to Printer
See calibration procedure at Web Site Copy / CD Copy available on the technical support 
page of the Allen Datagraph web site at http://www.allendatagraph.com. -> tech support 
-> Axxis -> SmartMark Sensor Page. 

A.4.2.13 Calibration Square Output
This diagnostic prompts for a square size and sends an HPGL command to output the 
square. This is useful when calibrating the Axxis to a ruler rather than a printer and is 
normally not required.  Specifying 6 inches for the size will send the HPGL job to the 
Axxis that will cut a 6 inch rectangle.

A.4.2.14 Default Calibration 08
This diagnostic sets the calibration constants back to the factory defaults prior to initial 
calibration.  After running this diagnostic you will have to either restore the calibration 
constants or rerun the procedure described in TSB on CalibrationWebsite Copy / CD 
Copy  or SmartmarkTM calibration  Web Site Copy / CD Copy available on the technical 
support page of the Allen Datagraph web site at http://www.allendatagraph.com.  As this 
is a rather involved procedure Diagnostic 08 should be avoided unless you have received 
an E37 error, which automatically runs this diagnostic.

A.4.2.15 FO Output
This diagnostic sends the <esc>.vfooutput: command which displays software debug 
information about the last SmartMarkTM scan.  The first line output indicates the location 
of the three targets and whether they were found.  The last two lines indicate the amount 
of scaling and rotation calculated that need to be applied to the HPGL commands to cut 
the image.

It normally is not useful for customers to run this diagnostic.  Information displayed is 
recorded in the serial.log file.

A.4.2.16 Smart Mark Setup
A.4.2.17 Sensor Offset
The SmartMark sensor is offset from the center of the 
knife.  The red dot indicates the LED point and the blue 
circle represent the knife.  This value is normally setup 
at the factory or during installation of the AXXIS.  The 
offset distance is preset at the factory, but may need to 
be  adjusted  on  occasion.  You  may  follow  this 
procedure only if you own a digitizing site  (Allen p/n 
PL-00-11-500).  Otherwise you must follow the manual 
procedure described in the TSB Calibration  Web Site 
Copy / CD Copy.
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To automatically reprogram the SmartMark sensor offset and sensor size parameters: 
Open the AXXIS Remote Panel.  Open the Diagnostics Menu and click on SmartMarkTM 

Setup

Before running this  procedure  run the 
Calibrate to Printer diagnostic.

1. Print the 6x3 rectangle in c:\Program Files\Allen Datagraph\Sample directory on 
the same printer you ran the “calibrate to printer diagnostic”.

2. Enter the designed size of the rectangle in the Rectangle Size boxes
3. Load Media into AXXIS.
4. Move  the  SmartMarkTM Sensor  beam near  the  lower  right  corner  of  the  6x3 

rectangle
5. Click on Find Sensor Size and Offset.  This determines the size of sensor based on 

the focal length and the current setting of the threshold.
6. After scanning the scale, skew, and origin points you will be asked to joystick the 

carriage to the lower right corner of the rectangle. Use either the optional fiber 
optic bombsite so that the center of the bombsite is directly above the lower right 
hand corner of the printed rectangle. 

7. Click on OK to save new values or Cancel to restore original values.  

You can review the numbers by opening the Setup Menu, click on Line Sensor Menu. 
See section describing the line sensor menu.
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 A.4.3 Customer Diagnostics
A.4.3.1 Set Model Number 03
This diagnostic allows setting model number into cutter so it knows it is an Axxis Cutter. 
Start diagnostic.  Enter model 208 for Axxis Finishing System then press the Select Key.

Model number can also be set from the Setup -> Options menu.

Model number should not be changed under normal circumstances.  Password to change 
model number is 23.

A.4.3.2 LAN address IP assignments 04
Normally you do not need to run this diagnostic.  If you are using a cross over cable the 
default address is 192.168.4.10 and you have set your computers ip address to 
192.168.4.2.  If you are using a dhcp server, most algorithms normally try to assign same 
ip address to mac address everytime the device requests an ip address.  If you have 
trouble with your dhcp server giving you a different ip address everytime you turn on 
your machine you can set a static ip address.

select -> right arrow to dia -> up arrow to 0004 -> select

select ip or dhcp (static / dynamically assigned)

change ip address part 1 (0-255) (use force/speed up/down to change value) select

change ip address part 2 (0-255) select

change ip address part 3 (0-255) select

change ip address part 4 (0-255) select

MAS is displayed. press select

change mask address part 1 (0-255) select

change mask address part 2 (0-255) select

change mask address part 3 (0-255) select

change mask address part 4 (0-255) select

GATE is displayed. press select

change gateway address part 1 (0-255) select

change gateway address part 2 (0-255) select

change gateway address part 3 (0-255) select

change gateway address part 4 (0-255) select

then power off cutter and back on.
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Example: if you want to set static ip to 192.168.3.30 with mask of 255.255.255.0 and gateway of 
192.168.3.1

you would:

select -> right arrow to dia -> up arrow to 4 -> select

select ip  (static)

change ip address part 1 192 select

change ip address part 2  168 select

change ip address part 3 3 select

change ip address part 4 30 select

MAS is displayed. press select

change mask address part 1 255 select

change mask address part 2 255 select

change mask address part 3 255 select

change mask address part 4 0 select

GATE is displayed. press select

change gateway address part 1 192 select

change gateway address part 2 168 select

change gateway address part 3 3 select

change gateway address part 4 1 select

A.4.3.3 Button Diagnostic 31 
Test the operation of each of the buttons on the front panel.  Buttons must be pressed as 
prompted by this display code, in the following order: Load, Pause, Copy, Speed Up, 
Speed Down, Force Up, Force Down, Test Cut, F3, F2, F1, Select, Left, Right, Up, 
Down.  If the wrong code is received the error code E036 is displayed otherwise the 
requested button is requested with  a prompt.

A.4.3.4 Confidence Test 02
The confidence test is used to verify the operation of the cutting station of the AXXIS.  It 
fully tests the capability of the cutting CPU and Servo control system.

First Load A size paper (8.5 x 11) into the cut station.  Lower pinch wheels.  Do not press 
load.  Insert a Pen into the tool holder.  Start diagnostic. 

A.4.3.5 Flag Monitor / Adjust 34
This diagnostic is used to verify the correct flag position on the cutting head.  It displays 
the knife height on the display. The flag is a small, flat, angled piece of metal which 
moves up and down between a pair of circuit board mounted sensors. The flag is held on 
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to the knife holder by 2 Allen screws, which are loosened slightly if adjustment is 
necessary. There are 3 locations the knife holder can be in. They are:

Bottom (remove the knife from the holder and press the holder down to the bottom) The 
display should read between 000 and 006. 

Down (press the knife down with a knife in the holder) The display should read 018 to 
040 pressing down with a knife in the holder (no media present). Adjust flag position if 
necessary.
Top (hold the knife up) The display should read 0060 or more.

The display should change immediately as you move the knife up or down.

Slightly move the flag to obtain the above reading at each of the three locations.

Check that the flag screws are tight and recheck Bottom and Down.

A.4.3.6 Flag Setup - Z Axis 58  
This diagnostic trains the Axxis to match the carriage installed.

Phase 4: Set Tool Bottom - Remove the tool from the holder and press the Select Key. 

Phase 5: Set Tool Down - Adjust knife depth guide to equal the blade length. Place knife 
tool in holder and press select key.

A.4.3.7 Label Mode 64  
On power up the label mode is set to on.  If you want to run without accumulators and 
stepper motors you can run this diagnostic and set label mode to off.  

A.4.3.8 LED and LCD display 29 
This diagnostic display characters on the 4 digit LCD display and flashes the LEDs. 

A.4.3.9 Line Sensor 21 
This diagnostic displays the amount of reflectance received back from the SmartMarkTM 

sensor.  It is normally < 20 for black and > 80 for white.

A.4.3.10 Amplifier Status
This diagnostics displays the temperature of the motor amplifiers

 A.4.4 Manufacturing Diagnostics
It is not recommended that the Manufacturing Diagnostics be run unless instructed 
by direct contact with Allen Datagraph Technical support.  Damage to the system is 
possible.

A.4.4.1 Collect Motor Position
Used by engineering to tune the servo system

A.4.4.2 Default Gains 48
Reset x, y , z axis gains to default values
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A.4.4.3 Lift/Lower Continuous 37
Exercises the z axis lift lower at different forces.  Continuously raises and lowers the 
knife.

A.4.4.4 Lift/Lower Demand 38
Exercises the z axis lift lower at different forces.  Raises and lowers the knife on each 
select key press.  While knife is down at a force the cutter displays the current through 
the voice coil and the width of the pwm pulse to the z axis driver.

A.4.4.5 Line Sensor Test
Used by engineering to tune the line sensor hardware

A.4.4.6 Motor Position Plot
Used by engineering to tune the servo system

A.4.4.7 Read Calibration Constants
Reads and displays the scaling constants for the x and y axes.  Safe to run.  X and Y 
encoder counts per inch are around 8000.

A.4.4.8 Spare Out
Used by engineering to test hardware

A.4.4.9 Tuning (Engineering)
Used by engineering to tune the servo system

A.4.4.10 Write Plot Data to Excel
Writes the last tuning graph to file that can be imported into an Excel spreadsheet.

 A.5 Label Interconnect
 A.5.1 Read All Sensors Continuously
Read and display the service loop sensor statuses.  As they are triggered by moving the 
dancers in the accumulators the status changes from 0 to 1.  Not used if analog sensors. 
Use diagnostic 41 and 42 instead.

 A.5.2 Reset Service Loop Sensor
Each of the service loop (accumulator) sensors detects the presence of dancer in the 
accumulator travel.  They are latched (set) on when triggered.  To reset the sensor states 
back to zero use this diagnostic.  Not used if analog sensors.  Use diagnostic 41 and 42 
instead.

 A.5.3 Supply motor on
Turn on supply motor (same as F2 on front panel)

 A.5.4 Supply motor off
Turn off supply motor (same as F2 on front panel)
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 A.5.5 Take up motor on
Turn on take up motor (same as F3 on front panel)

 A.5.6 Take up motor off
Turn off take up motor (same as F3 on front panel)

 A.6 Printer base station remote panel
 A.6.1 Diagnostics
A.6.1.1 Load / Takeup Switch
This diagnostic displays the current position of the on/off switch for the takeup and load 
buttons.

A.6.1.2 PWM Amplifier Status
This diagnostics displays the status of the motor amplifiers

A.6.1.3 Default Gain 48
Sets default gains for tuning servo.

A.6.1.4 Dancer and Takeup 49
If you replace a dancer sensor you must rerun this diagnostic to calibrate the mechanical 
adjustments to the software.  When you start diagnostic it will ask you to position the 
dancer accumulators is specified positions and press the 5 key to advance to next step.

A.6.1.5 Tuning (Engineering)
Used by engineering to tune the servo system

A.6.1.6 Write Plot Data to Excel
Used by engineering to tune the servo system

A.6.1.7 Write Table
Used by engineering to tune the servo system

 A.6.2 Firmware Installation
The printer base station remote panel is only used to load firmware and run diagnostics.

The firmware on this disk is provided for update purposes only and should not be  
installed on new machines.  In general you should not install a firmware update unless  
directed by a member of the technical support staff.  Firmware updates are available on 
the technical support page of the Allen Datagraph web site at  
http://www.allendatagraph.com.
This procedure details the firmware upgrade procedure.  Normally firmware is only sent 
to customers when a software problem is reported that has been fixed in a later version of 
the software.
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From time to time Allen Datagraph will recommend that you upgrade your firmware in 
your Allen Datagraph Axxis.  A file can be downloaded from the Allen Datagraph web 
site and saved to the desktop.  

Before running the setup program be sure to exit the older version of the Remote Panel.

Turn off your equipment. 
Press the black button next to 
the Ethernet connector on 
printer base and then, turn on 
the Allen Datagraph 
equipment to be upgraded. 
Start the Remote Panel by 
clicking on start, program, 
Allen Datagraph, Remote 
Panel.  Click on Setup, Com 
Port and verify that the correct 
port has a check next to its 
name.  Click on Action, 
Upload Firmware.  Select 
pic32standrel.hex file and click Open. If the upload fails, you will be given a backup 
procedure to follow on the computer screen.

 Appendix B – Error Codes
The mmc software error codes are in the following linked document. Web Site Copy / 
CD Copy. 

 Appendix C – Radio and Television Interference
NOTE: This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment.  This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, 
may cause harmful interference to radio communications.  Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense.

In order to maintain compliance with FCC regulations shielded cables must be used with 
this equipment.  Operation with non-approved equipment or unshielded cables is likely to 
result in interference to radio & television reception.

This device complies with part 15 of FCC Rules. Operation is subject to the following 
two conditions; (1) This device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired 
operation.
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